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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

このドキュメント 

• このドキュメントは，第２回ARC/CPSY/RECONF高性能コンピュータシステム
設計コンテストの概要とルールを説明するものです． 
 

• 設計コンテストのWEBサイト 
– http://aquila.is.utsunomiya-u.ac.jp/contest/ 

 
• 不明な点は，以下のいずれかの方法でお問い合わせください． 

– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

ドキュメントガイド 

• 本ファイルには以下のドキュメントが含まれます 
– P30 General Guide and Contest Rule 
– P32 Reference Design Test Manual (ATLYS board) 
– P40 Design Guide for Altera DE-2 board 
– P42 Reference Design Test Manual (DE2 board) 
– P33 Architecture of Reference Design Processor  
– P34 DRAM Memory Interface  
– P35 MIPS Cross Compiler Setup Manual  
– P36 SDK Setup Manual  
– P37 Application Specification of Processor Design Category 
– P51 Application Specification of Computer System Design Category 
– P61 User Manual of Optical Flow System Reference Design (Atlys board) 
– P62 User Manual of Optical Flow System Reference Design (DE2-115 board) 
– P70 Design Data Submission  

 
• これらのドキュメントは、第1回コンテストから大部分を流用しています 

– 参考）第１回IPSJ-ARC高性能プロセッサ設計コンテストのWEBサイト 
• http://www.arch.cs.titech.ac.jp/contest/ 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

コンテストの趣旨 

• 今後よりいっそう高度化・多様化が進む，コンピュータシステムの基盤技術を支

える研究者・技術者の育成と交流・ 研究開発の成果検証を目的に，コンピュー

タシステムの設計を競うコンテストを開催します．コンテスト参加者には，複数の

アプリケーション課題に対して処理 性能を高める事を目標として，FPGAボード

上で動作するコンピュータシステムを予め設計してもらいます． 

• 当日はコンテスト参加者の設計したコンピュータ システムを持ち寄り，実際に会

場で動作させることで性能を競います．プロセッサ技術・アーキテクチャ技術・リ

コンフィギャラブル技術や関連技術について， 最先端の研究開発の成果をアピ

ールする機会となることを期待します． 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

コンテストの重要日程 
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項目 日程 
参加登録の開始 ２０１４年 

６月６日（金） 
参加登録の締切 ７月２５日（金） 
予選デザインと予稿の原稿（1～4ページ）の提出  ８月４日（月） 昼１２時 

予選結果の公表（決勝進出チームの決定） ８月１１日（月） 
FIT2014デザインコンテスト予稿集の原稿 
（1～4ページ）の提出 

８月２２日（木） 

FIT2014のイベント企画にて 
デザインのポスター発表と決勝戦 

９月５日（金） 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

コンテストルール 1/6 

1. 実施形態はチーム制です．1～4人で1チームを構成して参加してください． 
2. 競技部門には2種類があります．選択して参加してください． 

– プロセッサ設計部門 
• プロセッサアーキテクチャを如何に高性能にするかを競う部門。基本的なアプリ

ケーションで性能を競う。 
– コンピュータシステム設計部門 

• 応用に近いアプリケーションで、複数種類の処理の組合せでシステムトータル
の性能を競う。  
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

コンテストルール 2/6 

3. プロセッサ設計部門の競技内容 
– 以下の4種類のいずれかのFPGAボードが参加可能です。 

• Digilent社 Atlys Spartan-6 FPGA Development Board (Xilinx) 
• Digilent社 Nexys4 Artix-7 FPGA Board (Xilinx) 
• Terasic社 Altera DE2-115 Development and Education Board 
• Terasic社 Cyclone V GX Starter Kit 

– アプリケーションプログラムは次の４つです． 
• 310_sort     ： 整数のソーティング 
• 320_mm      ： 行列積，要素は整数 
• 330_stencil ： ステンシル計算，要素は整数 
• 340_spath ： 最短経路問題 

– FPGAに実装されたプロセッサの処理時間を競います．  
• 実行委員が提供するデータ（256KB）を用いて，アプリケーションプログラムの処理時間を

測定し，スコアを計算します．  
– コンテストの参加者は，次のデザインを提出してください． 

• １種類のFPGAの回路情報（ファイル名は System.bit としてください） 
• ４種類の実行バイナリコード（256KBのバイナリファイルを４種類） 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

コンテストルール 3/6 

4. コンピュータシステム設計部門の競技内容 
– 以下の4種類のいずれかのFPGAボードが参加可能です。 

• Digilent社 Atlys Spartan-6 FPGA Development Board (Xilinx) 
• Digilent社 Nexys4 Artix-7 FPGA Board (Xilinx) 
• Terasic社 Altera DE2-115 Development and Education Board 
• Terasic社 Cyclone V GX Starter Kit 

– 課題となるアプリケーションプログラムは以下のものです． 
• 400_oflow     ： オプティカルフロー処理 

– FPGAに実装されたプロセッサの処理時間を競います．  
• 実行委員が提供する画像データ（JPEG様圧縮形式・別途説明、64KB ｘ 8フレーム）を用い

て，オプティカルフロー処理プログラムの処理時間を測定し，スコアを計算します．  
– コンテストの参加者は，次のデザインを提出してください． 

• １種類のFPGAの回路情報（ファイル名は System.bit としてください） 
• プログラムの起動方法に関するドキュメントと、必要なデータ・プログラム(elf)等

(2014/7/3訂正) 
 

8 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

コンテストルール 4/6 

5. 予選におけるスコアの計算方法と予選通過の条件 
– プロセッサ設計部門 

• それぞれのアプリケーションについて，実行時間の速いチームから順に，次の
点数を与えます． 1位 10点，2位 7点， 3位 5点， 4位 4点 

• 4種類のアプリケーションで獲得した点数の合計がスコアとなります． 
• 4種類のすべてのアプリケーションが規定時間（2分とします）内に正しい結果を

出力し，スコアが上位のチームが決勝に進出します． 
– コンピュータシステム設計部門 

• 課題アプリケーションの処理時間に応じて順位・スコアをきめ、スコアが上位の
チームが決勝に進出します． 

– ただし，参加チーム数等の状況により，点数を与える順位を調整することが
あります． 

– 予稿の品質があまりに低い場合は予選を通過しないことがあります． 
6. 決勝におけるスコアの計算方法 

基本的には予選に準じます。【後程公開】 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

コンテストルール 5/6 

7. 実行時間の計測方法 
– ホストからのUDP/IP(Ethernet)通信にて512KBのデータ（256KBのプロ

グラムと256KBのアプリケーションデータ）の送信開始時刻T1から，計算結
果を受け取り，最後にENDという文字列を受け取るまでの時刻T2を実行
時間(execution time) として計測します．すなわち，execution time = 
T2 – T1 です． 

– UDP/IPの通信は100Mbpsで行う事とします． 
8. 実行結果の検証 

– 設計した回路は，実行委員会が提供するツールキットと全く同じ結果を出
力（通信にてホスト計算機に送信）する必要があります．また，計算結果を
出力して，最後には END という文字列を出力してください． 

– すなわち，実行を開始してから，ホスト計算機が受信する END という文字
までの全てのデータ(2014/7/3訂正)がツールキットと等しくなるように回
路を設計してください． 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

コンテストルール 6/6 

9. ホストとの通信方法(2014/7/3追記) 
– プロセッサ設計部門 

• ホストとの通信には，実行委員から配布するイーサネット(100Mbps)・シリアル
(1Mbps)変換の小型ボードを用います． 

– コンピュータシステム設計部門 
• ホストとの通信には，実行委員から配布するイーサネット(100Mbps)・シリアル

(1Mbps)変換の小型ボード，もしくはFPGAボード上に搭載されているイーサネ
ットコネクタ(RJ-45)を用います． 

– 両部門共通 
• FPGAボードと小型ボードの間の接続に用いるピンは，リファレンスデザインの

ピン配置に準じます．すなわち，1Mbpsのシリアル通信と，リセット信号がリファ
レンスデザインと同様に動作する必要があります． 

• 各ボード毎に以下のコネクタを使用してください． 
– Atlys: PMODコネクタ  
– Nexys4: PMODコネクタ（JA） 
– DE2-115：2x20 GPIOコネクタJP5 
– Cyclone V GX Starter Kit：2x20 GPIOコネクタJP9 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

ハードウェアセットアップ 

• PCとFPGAボードを、小型ボード(exStick)を介して接続します 
– イーサネット(100Mbps)・シリアル(1Mbps)変換 
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FPGA 
board 

ネットワーク 
192.168.10.0/255.255.255.0 

192.168.10.64 
（64-79までDIPスイッチで設定可能） 

192.168.10.X 

exStick 

【注意】 
プロセッサ設計部門においては、かならずexStickを介してホストPCと通信します 
コンピュータシステム設計部門においては、ボード上のEthernetを用いてもOKです 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

参考）ATLYSボードの開発環境セットアップ 

• Windows 7 マシン と Atlysボード を USBケーブル で接続 
• FPGAボード用電源 を使ってAtlysボードに電源供給 
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USBケーブルで接続 
FPGAコンフィギュレーション用 

Ethernetで接続 
・専用のUDP_Clientプログラムで通信 

FPGAボード用電源 

Atlysボード 

Windows 7 マシン 

exStickボード 
ネットワーク 
192.168.10.0/255.255.255.0 

192.168.10.64 
（64-79までDIPスイッチで 
設定可能） 

192.168.10.X 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

参考）DE2-115ボードの開発環境セットアップ 

• Windows 7 マシン と DE2-115ボード を USBケーブル で接続 
• FPGAボード用電源 を使ってDE2-115ボードに電源供給 
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USBケーブルで接続 
FPGAコンフィギュレーション用 

Ethernetで接続 
・専用のUDP_Clientプログラムで通信 

FPGAボード用電源 

Atlysボード 

Windows 7 マシン 

exStickボード 
ネットワーク 
192.168.10.0/255.255.255.0 

192.168.10.64 
（64-79までDIPスイッチで 
設定可能） 

192.168.10.X 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

exStickボードの接続例 

Xilinx Atlysボード ALTERA DE2ボード 

裏返して、両方が長いピンヘッダで差
すとちょうどPMODの同じピン同士が 
接続されます 

標準ピンヘッダ6ピンのケーブル（1ピンず

らす）＋電源用ジャンパワイヤ、もしくは
ジャンパワイヤで1本ずつ接続します 
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開発環境 

• ホストPC 
– OS： Windows7 

• 動作確認済みのホストPC上のソフトウェア環境 
– java version "1.7.0_60“ 

• 既知の問題： CentOS6.5をホストPCとして用いた際に，UDP_Clientが正常に
通信できない問題が報告されています。 
 

• exStickBridgeでの動作確認済みスイッチ一覧 
– BUFFALO LSW3-TX-5EPL 
– BUFFALO BSL-WS-G2116M 
– （今後追加します） 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

設計を始めましょう 

• FPGAボード， USBケーブルなどの必要なハードウェアが揃っていない場合 
– コンテストホームページを参照の上，必要なハードウェアを揃えてください． 
– Atlysボード・Nexys4ボードは，貸し出し出来る可能性があります． 

希望者はお問い合わせください． 
contest_support@virgo.is.utsunomiya-u.ac.jp 
 

•  FPGAボード， USBケーブルなどの必要なハードウェアが揃っている場合 
– ドキュメント “P32 Reference Design Test Manual” を参考に， 

リファレンスデザインの動作テストをおこなってください． 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

配付ライセンスについて 

• FPGAデザインサンプルはGPLです． 
• ソフトウェア開発環境（SDK），ドキュメント類は修正BSDライセンスです． 
• 詳細は各パッケージ・ディレクトリに含まれるライセンスファイルを参照してくださ

い． 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 
第２回 ARC/CPSY/RECONF 高性能コンピュータシステム設計コンテスト 

The 2nd ARC/CPSY/RECONF  
High-Performance Computer System Design Contest  

Reference Design Test Manual 
（ATLYS board) 

コンテスト実行委員会コアチーム 
Version 2014-08-17 
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Document P32 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

このドキュメント 

• このドキュメントは，ツールキットに含まれるリファレンスデザインの概要とテスト
方法を説明するものです． 
 

• 設計コンテストのWEBサイト 
– http://aquila.is.utsunomiya-u.ac.jp/contest/ 

 
• 不明な点は，以下のいずれかの方法でお問い合わせください． 

– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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exStickの接続方法 

• 入出力ピン 
– exStickのPMODコネクタ(6x2) 

• P7: UART-TX (out) 
• P8: UART-RX (in) 
• P9: RST_X (in) 
• P10: INIT_FPGA_X (out) 

1 2 3 4 5 6 

PMODコネクタ 

7 8 9 10 11 12 

P5,P11: GND 
P6,P12: VDD(3.3V) 

P10はFPGAボードをリセットする信号です。 
リファレンスデザインは、exStickを接続して 
使用する必要があります。 
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exStickBridgeとAtlysボードの接続方法 

• 両方が長いヘッダピン（6x1）を用いて、AtlysボードのPMODコネクタに、 
逆さにしたexStickを接続して下さい 

• ピンの接続については以下の表の様になります 
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exStickBridge 方向 Atlys 
VDD(Pmod12番) - PMOD[6]:

3.3V 
GND(Pmod11番) - PMOD[5]:

GND 
INIT_FPGA_X(Pmod10番) → PMOD[4] 
RST_X(Pmod9番) ← PMOD[3] 
UART-RX (Pmod8番) ← PMOD[2] 
UART-TX (Pmod7番) → PMOD[1] 

PMODコネクタによる接続 

・両方が長いヘッダピン（6x1）は、exStick貸出し時に付属します。 
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Aｔｌｙｓボード 
FPGAのコンフィギュレーション 

• コンテストホームページから，プロセッサを含むリファレンスデザインの回路データ 
System_Atlys_t63 をダウンロードしてください． 

• System_Atlys_t63 をAdeptで書き込みます 
– ①Atlysボードが認識されていることを確認し、 

②Browseで先程のbitファイルを選択して、 
③Programで書き込みます 
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① 

③ ② 
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Aｔｌｙｓボード 
サンプルアプリケーションの実行（1） 

• Adeptで回路データ(bit)を書き込むと、LD0 が点灯，LD7 が点滅します 
– LEDの意味は本資料末尾の「参考：LEDの説明」をご覧ください． 

• これで，PMODのUARTポートが，プログラムデータを受信するための待ち受け
状態になります． 
– リセットボタンを押すと，FPGAを初期状態に戻すことが出来ます． 
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リセットボタンは 
こちら 

LEDはこちら 
LD0：点灯 
LD7：点滅 
で正常動作です 

PMOD 
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exStickBridgeを用いた 
リファレンスデザインの動作検証 （１） 

• 以下のファイルを用いて、exStickBridgeの動作検証を行います。 
– exStickBridge_v051.bit.zip  
– System_Atlys_t63.bit.zip 
– UDP_Client_v06.jar 
– SDK.1.1.1.tgz 

 
• 上記ファイルに対応するプロジェクトファイルは以下の通りです 

– System_Atlys_t63.zip (Xilinx ISE14.7プロジェクト) 
– UDP_Client_v06.zip (Eclipseプロジェクト) 
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exStickBridgeを用いた 
リファレンスデザインの動作検証 （２） 

• 動作検証のためのネットワーク環境 
– Pingコマンドで応答を確認可能 
– 動作確認済みのスイッチについては別表を参照 
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FPGA 
board 

ネットワーク 
192.168.10.0/255.255.255.0 

192.168.10.64 
（64-79までDIPスイッチで設定可能） 

192.168.10.X 

DIPスイッチ 

MACアドレスもDIPスイッチで変化します 
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exStickBridgeを用いた 
リファレンスデザインの動作検証 （３） 

• SDK-1.1.1.tgzを展開します 
• bin/xilinxディレクトリにある以下のファイルを、UDP_Client_v06.jarと同じデ

ィレクトリに置きます 
• 310sort512.bin, 320mm512.bin, 330stencil512.bin, 340spath512.bin 

– 以下のコマンドで、4つのアプリを順次実行します。 
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% java –cp UDP_Client_v06.jar jp.ac.utsunomiya.is.UDP_Client 192.168.10.64 
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exStickBridgeを用いた 
リファレンスデザインの動作検証 （４） 

• 実行 
– データ転送は8秒程度 
– 4つのアプリが順次実行される 
– アプリ開始時にFPGAボードが毎

回リセットされる（リセットのために
16バイトのUDPパケットを送信） 

• 以下のログファイルが出力 
– ToUDP: 送信したデータ 
– FromUDP: 受信したデータ 

• UDP通信のエラーが無いか確認するに
は、199transfer512.binを使用可能 
– FPGA上のプログラムが、データ領

域のデータ全てを、PCに送ります 
– つまり199transfer512.binの後

半256KB(199transfer.dat)と
FromUDP.binが一致するはず 
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% java –cp UDP_Client_v06.jar 
jp.ac.utsunomiya.is.UDP_Client 192.168.10.64 

199transfer512.bin  
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参考：LEDの説明 

• リファレンスデザインにおける下図の赤枠で囲んだ各LEDは以下の状態を示し
ます． 
 

76543210 

0: メモリイメージの転送完了 
1: DRAMのキャリブレーションが完了 
2: シリアル通信中(受信) 
3: シリアル通信中(送信) 
4: DRAMがbusy状態 
5: プロセッサの命令デコードエラー 
6: プロセッサのメモリアライメントエラー 
7: heartbeat（一定間隔で点滅） 
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参考：LEDの説明 詳細 

• ツールキットに含まれる Verilog HDL 記述を示します． 
• rtl/MieruSys.vに、LEDへの出力の内容が記述されています 

– LD7 (ULED[7])： カウンタの25ビット目なので、約33Mクロックで点滅 
– LD0(ULED[0])： リセット時転送、イメージの転送が完了すると消えます 
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    always @(posedge CLK) ULED[7] <= cnt_t[25]; 
    always @(posedge CLK) ULED[6] <= CORE_STAT[1];       // Processor Memory Alignment Error 
    always @(posedge CLK) ULED[5] <= CORE_STAT[0];       // Processor Decode Error  
    always @(posedge CLK) ULED[4] <= mem_busy;           // DRAM is working 
    always @(posedge CLK) ULED[3] <= ~TXD;               // Uart TXD 
    always @(posedge CLK) ULED[2] <= ~RXD;               // Uart RXD 
    always @(posedge CLK) ULED[1] <= ~calib_done;        // DRAM calibration done  
    always @(posedge CLK) ULED[0] <= ~INIT_DONE;         // MEMORY IMAGE transfer is done 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 
第２回 ARC/CPSY/RECONF 高性能コンピュータシステム設計コンテスト 

The 2nd ARC/CPSY/RECONF  
High-Performance Computer System Design Contest 

Design Guide for Altera DE-2 board 
コンテスト実行委員会コアチーム 

Version 2014-08-17 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

このドキュメント 

• このドキュメントは，第２回ARC/CPSY/RECONF高性能コンピュータシステム
設計コンテストにおいてAltera DE2-115 開発ボードを使用する場合に必要と
なる情報を提供する事を目的とします． 
 

• 設計コンテストのWEBサイト 
– http://aquila.is.utsunomiya-u.ac.jp/contest/ 

 
• 不明な点は，以下のいずれかの方法でお問い合わせください． 

– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

ドキュメントガイド 

• 本ドキュメントを読む前に，本コンテストの「General Guide and Contest Rule」
を熟読されている事を前提とします． 

 
• DE2-115ボードの仕様について下記のドキュメントを参考にして下さい 

– DE2_115_User_Manual.pdf（DE2-115ボードに付属のCDにあります） 
• Alteraのツールの基本的な使用方法等については，最低限下記のドキュメント

の内容を理解されていると仮定してます． 
– Introduction to the Altera Qsys System Integration Tool 
– Making Qsys Components 
（AlteraのWebサイトの「トレーニング」->「ユニバーシティプログラム」をクリッ
クして現れるサイトの左側にあるEducational Materials -> Computer 
Organization ->Tutorialsからダウンロードできます） 
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ハードウェアセットアップ 

• PCとFPGAボードを、小型ボード(exStick)を介して接続します 
– イーサネット(100Mbps)・シリアル(1Mbps)変換 
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FPGA 
board 

ネットワーク 
192.168.10.0/255.255.255.0 

192.168.10.64 
（64-79までDIPスイッチで設定可能） 

192.168.10.X 

exStick 
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DE2-115ボードの開発環境セットアップ 

• Windows 7 マシン と DE2-115ボード を USBケーブル で接続 
• FPGAボード用電源 を使ってDE2-115ボードに電源供給 
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USBケーブルで接続 
FPGAコンフィギュレーション用 

Ethernetで接続 
・専用のUDP_Clientプログラムで通信 

FPGAボード用電源 

Atlysボード 

Windows 7 マシン 

exStickボード 
ネットワーク 
192.168.10.0/255.255.255.0 

192.168.10.64 
（64-79までDIPスイッチで 
設定可能） 

192.168.10.X 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 
第２回 ARC/CPSY/RECONF 高性能コンピュータシステム設計コンテスト 

The 2nd ARC/CPSY/RECONF  
High-Performance Computer System Design Contest  

Reference Design Test Manual 
コンテスト実行委員会コアチーム 

Version 2014-08-17 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

このドキュメント 

• このドキュメントは，Altera DE2-115ボードを用いた場合の，ツールキットに含
まれるリファレンスデザインの概要とテスト方法を説明するものです． 
 

• 設計コンテストのWEBサイト 
– http://aquila.is.utsunomiya-u.ac.jp/contest/ 

 
• 不明な点は，以下のいずれかの方法でお問い合わせください． 

– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

exStickBridgeの接続方法 

• 入出力ピン 
– exStickのPMODコネクタ(6x2) 

• P7: UART-TX (out) 
• P8: UART-RX (in) 
• P9: RST_X (in) 
• P10: INIT_FPGA_X (out) 

1 2 3 4 5 6 

PMODコネクタ 

7 8 9 10 11 12 

P5,P11: GND 
P6,P12: VDD(3.3V) 

P10はFPGAボードをリセットする信号です。 
リファレンスデザインは、exStickを接続して 
使用する必要があります。 
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exStickBridgeとDE2-115ボードの接続方法 

• ジャンパー線を用意してexStickBridgeとDE2-115ボードのGPIOと接続して
下さい 

• ピンの接続については以下の表の様にします 
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exStickBridge DE2-115 
VDD(Pmod12番) GPIOの3.3V 
GND(Pmod11番) GPIOのGND 
INIT_FPGA_X(Pmod10番) GPIO[9] 
RST_X(Pmod9番) GPIO[7] 
UART-RX (Pmod8番) GPIO[5] 
UART-TX (Pmod7番) GPIO[3] 

ジャンパー線による接続例 

・標準ピンヘッダ間を繋ぐケーブル(5x1や6x1)があれば使用可能です。 
・両方が長いヘッダピン（6x1）は、exStick貸出し時に付属します。 
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exStickBridgeを用いた 
リファレンスデザインの動作検証に必要なファイル 

• 以下のファイルを用いて、exStickBridgeの動作検証を行います。 
– exStickBridge_v051.bit.zip  
– MieruSys10.sof.zip 
– UDP_Client_v06.jar 
– SDK-1.1.1.tgz 

 
• 上記ファイルに対応するプロジェクトファイルは以下の通りです 

– MieruSys10.zip (Aletra Quartus 13.1プロジェクト) 
– UDP_Client_v06.zip (Eclipseプロジェクト) 
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DE2-115ボード 
FPGAのコンフィギュレーション 

• コンテストホームページから，プロセッサを含むリファレンスデザインの回路データ
MieruSys10.sof.zipをダウンロードしてください． 
（解凍するとMieruSys.sofというファイルになります） 

• De2-115ボードの電源をいれます． 
• MieruSys.sofをQuartusから起動できるProgrammerで書き込みます 

– ①Hardware SetupでUSB Blasterが選択されている事を確認 
– ②Add fileでMieruSys10.sofを選択して追加します 
– ③Startで書き込みます 
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① 

③ 

② 
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DE2-115ボード 
サンプルアプリケーションの実行（1） 

• Programmerで回路データ(sof)を書き込むと、LEDG0 が点灯，LEDG7 が点
滅します 
– LEDの意味は「参考：LEDの説明」をご覧ください． 

• これで，PMODのUARTポートが，プログラムデータを受信するための待ち受け
状態になります． 
– リセットボタンを押すと，FPGAを初期状態に戻すことが出来ます． 
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リセットボタンは 
こちら 

LEDはこちら 
LD0：点灯 
LD7：点滅 
で正常動作です 
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参考：LEDの説明 

• リファレンスデザインにおける下図の赤枠で囲んだ各LEDは以下の状態を示し
ます． 
 

76543210 

0: メモリイメージの転送完了 
1: 常に0 
2: シリアル通信中(受信) 
3: シリアル通信中(送信) 
4: DRAMがbusy状態 
5: プロセッサの命令デコードエラー 
6: プロセッサのメモリアライメントエラー 
7: heartbeat（一定間隔で点滅） 
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exStickBridgeを用いた 
リファレンスデザインの動作検証 （1） 

• 動作検証のためのネットワーク環境 
– Pingコマンドで応答を確認可能 
– 動作確認済みのスイッチについては別表を参照 
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FPGA 
board 

ネットワーク 
192.168.10.0/255.255.255.0 

192.168.10.64 
（64-79までDIPスイッチで設定可能） 

192.168.10.X 

DIPスイッチ 
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exStickBridgeを用いた 
リファレンスデザインの動作検証 （2） 

• SDK-1.1.1.zipを展開します 
• bin/alteraディレクトリにある以下のファイルを、UDP_Client_v06.jarと同じデ

ィレクトリに置きます 
• 310sort512.bin, 320mm512.bin, 330stencil512.bin, 340spath512.bin 

– 以下のコマンドで、4つのアプリを順次実行します。 
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% java –cp UDP_Client_v06.jar jp.ac.utsunomiya.is.UDP_Client 192.168.10.64 
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exStickBridgeを用いた 
リファレンスデザインの動作検証 （3） 

• 実行 
– データ転送は8秒程度 
– 4つのアプリが順次実行される 
– アプリ開始時にFPGAボードが毎

回リセットされる（リセットのために
16バイトのUDPパケットを送信） 

• 以下のログファイルが出力 
– ToUDP: 送信したデータ 
– FromUDP: 受信したデータ 

• UDP通信のエラーが無いか確認するに
は、199transfer512.binを使用可能 
– FPGA上のプログラムが、データ領

域のデータ全てを、PCに送ります 
– つまり199transfer512.binの後

半256KB(199transfer.dat)と
FromUDP.binが一致するはず 
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% java –cp UDP_Client_v06.jar 
jp.ac.utsunomiya.is.UDP_Client 192.168.10.64 

199transfer512.bin  
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第２回 ARC/CPSY/RECONF 高性能コンピュータシステム設計コンテスト 

The 2nd ARC/CPSY/RECONF  
High-Performance Computer System Design Contest  

Architecture of Reference Design 
Processor (ALTERA DE-2 board) 

コンテスト実行委員会コアチーム 
Version 2014-08-17 
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このドキュメント 

• このドキュメントでは，Aletara DE2-115ボード用のリファレンスデザインに含ま
れるシステム構成について説明します． 

• また，Altera Quartusを用いて，リファレンスデザインの回路ファイル（sofファ
イル）を生成する方法を示します． 

 
• 設計コンテストのWEBサイト 

– http://aquila.is.utsunomiya-u.ac.jp/contest/ 
 

• 不明な点は，以下のいずれかの方法でお問い合わせください． 
– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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最初に 

• Altera版MieruSysはXilinx版MieruSysと機能的には同じですが，異なる所
が多々ありますので，注意して下さい． 
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MieruSysのブロック図 

Contest 
UART 

MIPS 
avalon 

interface 

MIPS 

On-chip 
Memory 
(256kB) 

SDRAM 
Interface 

PLL 

mips_sys 

MieruSys 

SDRAM 
(128MB) UART 
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各機能の役割 

• PLL 
– 40MHzのクロックを供給 

• On-chip Memory（256kB） 
– MIPSの命令メモリとして使用 

• SDRAM 
– MIPSのデータメモリとして使用． 

• Contest UART 
– データ転送用のインターフェース． 
– UARTから受信したデータを命令メモリ，データメモリに保存する 
– MIPSからはUARTの送信ポート(TX)しかアクセスできない． 

• MIPS 
– MIPS本体の記述はAtlysボード用のMIPSと同じ． 
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Contest UARTの詳細 
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Contest UART 
 avalon interface 

avalon bus 

UART RX to char 

char to int 

memory access 
(program loader) 

UART TX  

 

mips access 
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Contest UARTの詳細 

• contest UART avalon interface 
– プログラムローダーやUART TXに対してavalonバスとのinterfaceになる 

• memory access 
– モジュール名はmemory aceessとなっているがプログラムローダーとして働く

．つまり受信データの先頭256kBを命令メモリに書き込み，残り256kBをデー
タメモリに書く 

– char to int 
• UART RXを8ビットのデータにしたものを32ビットのデータにしてmemory access 

モジュールに渡す 
– UART RX to char 

• シリアルで入力されるUART RXのデータを8ビットのデータに変換する 
• mips access 

– データ受信前にMIPSをリセット状態でkeepさせ，データ受信後にそれを解除
する 
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メモリマップ 

メモリアドレス 
開始アドレス 終了アドレス 

0x0000_0000 0x0003_FFFF on-chip memory 
0x0004_1000 0x0004_1000 UART_TX 
0x0004_1020 0x0004_102F MIPS 
0x0800_0000 0x0FFF_FFFF SDRAM 

補足 
• SDRAMの領域は0x0800_0000番地から使用出来るのですが， 

リファレンスデザインでは0x0c00_0000番地から使用しています． 
（SDRAM領域の0x0800_0000番地からの領域をデバッグに用いていたため） 
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リファレンスデザインの作成について 

• 次ページ以降で作成するリファレンスデザインの作成方法では，Verilog-HDL
の記述は既に完成しているものを使用するとします． 

• 本ドキュメントで参照するファイルは以下のものです． 
– MieruSys10.tar.gz 

• DE2-115ボード用プロセッサ設計部門リファレンスデザインのプロジェクトファイ
ル 

– DE2-115.qsf 
• DE2-115ボード用ピン設定ファイル．下記のURLから取得できます 

http://www.altera.com/education/univ/materials/boards/de2-115/unv-
de2-115-board.html 
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新規プロジェクトの作成 

1. プロジェクトを置くディレクトリは新規に空のディレクトリを作成する．ここでは
MieruSys11とします 

2. 新規に作成したディレクトリでQuartus を起動する 
3. File -> New Project Wizardを選択 

1. プロジェクト名をトップモジュール名（MieruSys）にする（次ページ左写真）． 
その後Next 

2. Add fileでは何も追加しない 
3. デバイス名はCyclone IV E EP4CE115F29C7を選ぶ（次ページ右写真） 
4. EDA toolの設定でSimulationツールとしてModelsimを選んでいる場合は

FormatをVerilog HDLにする 
5. その他はデフォルトでNextを押し，finishまでいく 
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新規プロジェクトの作成 
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Name filterでデバイス名の候補を 
filteringできる 
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Qsysの起動と外部クロックの設定 

• ここではQsysのシステムとしてmips sysを作成します． 
• Tools -> QsysでQsysを起動する 

（以下Qsysでの操作です．） 
• File -> Save でmips_sysという名前をつけて保存 
• clk_0を右クリックして，Edit 

– そこで40MHzと設定 
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Qsysの起動と外部クロックの設定 
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クロックの設定 

ファイルの保存 
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SDRAM Controllerの追加 

• Library から Memories and Memory Controllers->External Memory 
Interfaces-> SDRAM Interfaces -> SDRAM Controllerを選択し，Add 

• 現れたWindowで以下を設定する 
– Data Width: 32 
– Address Width 

• Row: 13，Colum: 10 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

SDRAM ControllerのTiming設定 

• Timingタブをクリック 
– Issue one refresh command every を7.8125us 
– Delay after powerupを200us 

• Finishボタンをクリック 
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SDRAM Controllerのclk配線など 

• 追加したsdram controllerの名前をsdramに変更（
new_sdram_controller_0という名前の上で右クリックを押して現れるメニュー
からRenameを選択） 

• クロックモジュールからclkをsdram controllerのclkに配線 
• sdramのwireをExportするようにExport欄をダブルクリック．（Export名を 

sdram_wireとする） 
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On-Chip memoryの追加 

• Library から Memories and Memory Controllers-> On-Chip -> On-Chip 
Memory(RAM or ROM)を選択し，Add 
– Total Memory Sizeを262144とする(256k) 
– Finishをクリックする 

• 名前をonchip_memoryに変更 
• onchip_memoryのclk1をclk_0のclkと接続する 
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MIPS avalon interfaceをComponentとして登録 

• ProjectのNew Componentを選択して，Add 
• Component Typeタブ内 

– Name, Display Nameを”mips_avalon_interface”とする 
– Groupを”My Own IP Core”とする 

 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

MIPS avalon interfaceをComponentとして登録 

• Filesタブ内 
– （プロジェクトディレクトリ内にリファレンスデザインのプロジェクトディレクトリ

にあるMipsCore.vとmips_avalon_interface.vをコピーしておく） 
– Synthesis Filesとして，mips_avalon_interface.vとMipsCore.vを追加す

る（mips_avalon_interface.vがTop-level Fileとなっているのを確認） 
– Analyze Synthesis Filesボタンをクリック 

このボタン
を押す事で 
ファイルの
追加 
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MIPS avalon interfaceをComponentとして登録 

• Signalsタブ内 
– clockのinterfaceの所を選択して，new Clock Inputを選択し，interface

欄がclock_sinkとなるようにし，Signal Typeをclkとする 
– resetのinterfaceの所を選択して，new Reset Inputを選択し，

interface欄がreset_sinkとなるようにする． 

clock_sinkを選択している所 
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MIPS avalon interfaceをComponentとして登録 

• Interfaceタブ内 
– Remove Interfaces With No Signalsボタンを押す 
– s1のAssociated Clockをclock_sinkに，Associated Resetをreset_sink

にする 
– imem, dmem, conduit_end_0のAssociated Clock, Associated Reset

も同様にする 
– reset_sinkのAssociated Clockをclock_sinkにする 

• Finishボタンを押し，保存するかどうかを訪ねるWindowが出たら，Saveを選ぶ
． 
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MIPS avalon interfaceをComponentとして登録 
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Remove Interfaces With No Signalsボタン 
はWindowの下の方にあり，クリックすると 
図の様にクリックできない状態になる 
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MIPS avalon interfaceを追加 

• ProjectのMy Own IP Core内のmips_avalon_interfaceを選択してAdd 
– Finishボタンをクリック 

• mips_avalon_interfaceのclock_sinkをclk_0のclkと接続 
• mips_avalon_interfaceのimemをonchip_memoryのs1と接続 
• mips_avalon_interfaceのdmemをsdramのs1，onchip_memoryのs1と接続 
• mips_avalon_interfaceのconduit_end_0のexport欄をダブルクリックして，

export名をmips_ledとする 
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MIPS avalon interfaceを追加 
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配線の様子 

conduit_end_0のexport 
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contest uart avalon interfaceをComponentとして登録 

• ProjectのNew Componentを選択して，Add 
• Component Typeタブ内 

– Name, Display Nameを”contest_uart_avalon_interface”とする 
– Groupを”My Own IP Core”とする 

• Filesタブ内 
– （プロジェクトディレクトリ内にリファレンスデザインのプロジェクトディレクトリ

にある以下のファイルをコピーしておく 
• contest_uart_avalon_interface.v 
• memory_access_module.v 
• mips_access_module.v 
• system.v 
• define.v 

– Synthesis Filesとして，define.v以外の上記4つのVerilog HDLファイル
を追加する（contest_uart_avalon_interface.vがTop-level Fileとなって
いるのを確認） 

– Analyze Synthesis Filesボタンをクリック 
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contest uart avalon interfaceをComponentとして登録 

• Signalsタブ内 
– clockのinterfaceの所を選択して，new Clock Inputを選択し，interface

欄がclock_sinkとなるようにし，Signal Typeをclkとする 
– resetのinterfaceの所を選択して，new Reset Inputを選択し，

interface欄がreset_sinkとなるようにする． 
• Interfaceタブ内 

– Remove Interfaces With No Signalsボタンを押す 
– s1のAssociated Clockをclock_sinkに，Associated Resetをreset_sink

にする 
– m1, conduit_end_0のAssociated Clock, Associated Resetも同様にす

る 
– reset_sinkのAssociated Clockをclock_sinkにする 

• Finishボタンを押し，保存するかどうかを訪ねるWindowが出たら，Saveを選ぶ
． 
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contest uart avalon interfaceを追加 

• ProjectのMy Own IP Core内のcontest_uart_avalon_interfaceを選択して
Add 
– Finishボタンをクリック 

• contest_uart_avalon_interfaceのclock_sinkをclk_0のclkと接続 
• contest_uart_avalon_interfaceのm1をmips_avalon_interfaceのs1，

onchip_memoryのs1，sdramのs1と接続 
• contest_uart_avalon_interfaceのs1をmips_avalon_interfaceのdmemと

接続 
• contest_uart_avalon_interfaceのconduit_end_0のexport欄をダブルクリ

ックして，export名をexportとする 
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contest uart avalon interfaceを追加 
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メモリマップの作成 

• メモリマップとしてbase addressを以下のように指定して，ロック 
– sdramのmemory: 0x0800_0000  
– onchip_memory: 0x0000_0000 
– mips_avalon_interface_0: 0x0004_1020 
– contest_uart_avalon_interface_0: 0x0004_1000 

 

ロックを外した状態で 
アドレスを入力し， 
その後ロックをかける 
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mips_sysの生成 

• メニューSysmem -> Create Global Reset Networkをクリック 
• この時点で，Qsys下部のMessageからエラー表示がなくなっているはず 
• mips_sysを保存 
• メニューGenerate -> Generateをクリック 

– Generateボタンをクリック 
• ちなみに，Mips_Core.vやmips_avalon_interface.vを変更する度に，Qsysで

Generateする必要があります 
• 以上で，Qsysは終了してOK 

Generateでは 
右下のGenerateボタンを 
押すだけでよい 
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PLLの追加 

• QuartusのメニューTools->MegaWizard Plug-In Manageをクリック 
– Nextをクリック 
– I/OのALTPLLを選択し，出力ファイル名をpll.vとし，Nextをクリック 

（次ページの画面1） 
– PLLの設定 

• Parameter Setting -> General/Mode内の入力クロックを50MHzに設定 
（次ページの画面2） 

• Output Clock -> clk c0のEnter output clock frequencyのラジオボタンを選
択し，40MHzと入力 
（2ページ先の画面3） 

• Summaryでは，選択可能なチェックボックスを全て外し，Finishボタンを押す 
• IPをprojectに登録するかどうか聞かれるので，登録する 
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PLLの追加 

78 

画面1 

画面2 

ここの欄が現在設定している 
項目を示すタブになっている 
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PLLの追加 
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画面3 

画面4 

最初にラジオボタンを選択してから， 
周波数の数値を入力する 

チェックを外す 
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プロジェクトへのファイルの追加 

• あらかじめ，MieruSys.vをプロジエクトディレクトリにコピーしておく 
• Porject -> Add/Remove files in Projectで以下のファイルを追加する 

– MieruSys.v 
– mips_sys.qsys 

• 追加したらOKボタンを押してウィンドウを閉じる 

ここをクリックして追加するファイルを選択し，その後addボタンを押す 
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ピン配置情報のimportと割当 

• Assignments -> Import Assignmentsをクリック 
– DE2_115.qsfを選択し，importする 

• Assignments -> Pin Plannerをクリック 
– 現れるウィンドウの下の方にある各ピンの設定で，GPIO[3]を右クリックし

現れるメニューの中から，Edit->Deleteを選択して削除する 
（次ページの画面1） 

– 同様に GPIO[5], GPIO[7], GPIO[9]のピン設定を削除する 
– 以下の表の様に未割当の入出力信号にピンを割り当てる 
– メニューFile -> closeをクリックして，ウィンドウを閉じる 

Node Name Location I/O Standard 補足 

GPIO_RXD PIN_Y17 3.3V LVCMOS GPIO[3] 
GPIO_TXD PIN_Y16 3.3V LVCMOS GPIO[5] 
GPIO_FLUSH_X PIN_AE16 3.3V LVCMOS GPIO[7] 
GPIO_INIT_X PIN_AE15 3.3V LVCMOS GPIO[9] 
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ピン配置情報のimportと割当 

82 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

ピン割当結果 
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構成情報の生成 

• Processing -> Start Compilationをクリックして，論理合成＆配置配線 
• DE2-115ボードの電源をいれる． 
• Taskウィンドウ内のProgram Device( Open Programmer)をダブルクリック 
• Programmer内にて，Hardware Setupボタンをクリック． 

– No Hardwareとなっている所をUSB-Blaster USBを選択して，closeボタ
ンをクリック 

• Start ボタンを押して，Progress が100%(Successful）になればOK 
• Programmerを閉じる 

 
• プロセッサ設計部門のプログラムの転送方法は，「P42Reference Design 

Test Manual」を参照して下さい． 
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このドキュメント 

• このドキュメントでは，Atlysボード向けリファレンスデザインに含まれるプロセッ
サの構成（アーキテクチャ）について説明します． 

• また，Xilinx ISEを用いて，リファレンスデザインの回路ファイル（bitファイル）
を生成する方法を示します． 

 
• 設計コンテストのWEBサイト 

– http://aquila.is.utsunomiya-u.ac.jp/contest/ 
 

• 不明な点は，以下のいずれかの方法でお問い合わせください． 
– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 

86 

http://aquila.is.utsunomiya-u.ac.jp/contest/
http://aquila.is.utsunomiya-u.ac.jp/contest/
http://aquila.is.utsunomiya-u.ac.jp/contest/
https://groups.google.com/forum/?hl=ja%23!forum/hpcpsy2014dc


The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

Memory Map of ToolKit Ver.1 Reference Design 
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Memory Map of ToolKit Ver.1 Reference Design 

• Atlysボードには，128MBのDRAMが搭載されており，これを自由に用いること
ができます． 

• 512KBのデータをシリアル通信でFPGAに送信します． 
• 512KBのデータは256KBの InitU, 256KBのInitS により構成されます． 

– InitUは参加者が提供するデータで，プロセッサが実行するプログラムなど
を格納してください． 

– InitSは実行委員会が提供するデータで，アプリケーションのための入力
パラメータや入力データが格納されます． 

• リファレンスデザインでは，受信した512KBのデータをDRAMの０番アドレスか
ら順に格納します． 
– すなわち，0x00000000 ～ 0x0007FFFF に，512KBのデータが格納さ

れます． 
• リファレンスデザインでは，プロセッサが実行する命令を格納するために，

64KBの命令メモリを実装しています． 
– 512KBのデータの先頭の64KBのみが，この命令メモリに格納されます． 
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Memory Mapped I/O of the Reference Design 

• FPGAからexStickBridgeへの出力は，シリアル通信を用います． 
• リファレンスデザインのプロセッサは，アドレス 0 にストアすると，そのデータが

シリアル通信で送信されます． 
• 但し，UDPパケットの送信は1024バイトのデータがたまってから行われます． 

– 例えば，Cのアプリケーションプログラムで次の記述をおこなうと A がターミ
ナルに表示されます． 
 
 

 
 
– ただし，シリアル通信のモジュールは送信バッファを持たないため，複数の

文字を送信する場合には，ソフトウェアでウェイトを入れてください． 
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{ 
    volatile int *uart_txd = (int*)0; 
    *uart_txd = ‘A’; 
} 

{ 
    volatile int *uart_txd = (int*)0; 
    *uart_txd = ‘A’; 
    mylib_wait();  /* user defined function  */ 
    *uart_txd = ‘B; 
} 
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リファレンスデザインに含まれるプロセッサ 
• リファレンスデザインには，5段パイプライン処理の典型的なMIPSプロセッサが採用され

ています．そのデータパスを下に示します． 
• このプロセッサは，ロード・ストア命令としてワード単位の命令のみをサポートします．アプ

リケーションでは char, short, float, double といったデータ型は利用しないでください． 
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データパス - Ifステージ – (1/5) 

• 命令メモリから命令をフェッチし，プログラムカウンタ(PC)を設定します 
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データパス - Idステージ – (2/5) 

• フェッチした命令をデコードしながら，レジスタを呼び出します 
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データパス - Idステージ – (2/5) 

• フェッチした命令をデコードします． 
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データパス - Idステージ – (2/5) 

• フェッチした命令をデコードします． 
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データパス - Exステージ – (3/5) 

• 命令操作の実行またはアドレス生成を行います 
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データパス - Exステージ – (3/5) 

• 命令操作の実行またはアドレス生成を行います． 
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データパス - Maステージ – (4/5) 

• データ・メモリ中のオペランドにアクセスします． 
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データパス - Wbステージ – (5/5) 

• 結果をレジスタに書き込みます 
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Atlysボード 
FPGA回路データ(bitファイル)の作成方法 

• ホームページからSystem_Atlys_t63.zipをダウンロードし，展開します． 
• fpgaディレクトリ中にある main.xise をISEで開きます． 
• ①トップモジュール(MieruSys)をクリックで選択し、 

②Generate Programming Fileをダブルクリックすると，数分で完了します． 
「Process “Generate Programming File” completed successfully」 

• 作成した回路データファイルは 
fpga/mierusys.bit 
です． 

• README.ｔｘｔ  
も参考にしてください． 
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このドキュメント 

• このドキュメントでは，Digilent Atlysに搭載されているFPGAとDRAMを対象と
し，Xilinx Memory Interface Generator を用いたDRAMモジュールの生成
方法を説明します． 

• ここでは，リファレンスデザインに含まれるシンプルなDRAMコントローラの生成

方法を説明しています．高性能化のための様々な設定がありますので，性能向
上のために試してみてください． 

• ただし，このDRAMモジュールの変更は難しいので，FPGA開発に慣れてきた
段階で挑戦してください． 

 
• 設計コンテストのWEBサイト 

– http://aquila.is.utsunomiya-u.ac.jp/contest/ 
• 不明な点は，以下のいずれかの方法でお問い合わせください． 

– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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DRAM on Atlys Board 

• Atlysに搭載されているDRAM 
• DDR2 128MByte 

–  MIRA P3R1GE3EGF G8E DDR2  
– 16-bit data bus, 64M locations  

• Xilinx Memory Interface Generator で用いる主なパラメータ 
– selecting the “EDE1116AXXX-8E” device 
– RZQ pin location : L6 
– ZIO pin location : C2 
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Xilinx Memory Interface Generator (1) 

• ISEから Project -> New Source -> IP 
– Memories & Storage Elements -> Memory Interface Generator 
– MIG を 選択して MIG を起動 

• Next を選択 
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Xilinx Memory Interface Generator (2) 

• Create Design を選択 
• Component Name : dram に設定 
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Xilinx Memory Interface Generator (3) 

• Pin Compatible FPGAs では，チェックをいれない 
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Xilinx Memory Interface Generator (4) 

• チェックボックスはチェックしない 
• Bank 3 を DDR2 SDRAM に設定 
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Xilinx Memory Interface Generator (5) 

• 3000 ps, EDE1116AXXX-8E を選択  
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Xilinx Memory Interface Generator (6) 

• Fullstrength, 50ohms, Enable, Disable を選択 
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Xilinx Memory Interface Generator (7) 

• Two 32-bit bi-directional and four 32-bit unidirectional ports を選択 
• Port0 をチェック， [ROW, BANK, COLUMN] をチェック 
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Xilinx Memory Interface Generator (8) 

• Next で次に進む 
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Xilinx Memory Interface Generator (9) 

• STTL output Drive Strength : Class II, Class II を選択 
• Calibrated Input Termination を選択 
• RZQ pin location : L6 
• ZIO pin location : C2 
• Debug : Disable 
• Clock : Single-Ended 
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Xilinx Memory Interface Generator (10) 

• ISE CORE Generator 
– View HDL Instantiation Template のコードを dram_mem.v にコピーし

てワイヤを修正 
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Xilinx Memory Interface Generator (11) 

• 論理合成でエラーになるので，生成されたVerilogコードを修正 
– fpga/ipcore_dir/dram/user_design/rtl/infrastructure.v 

 の 151行目付近を編集 
– IBUFG を用いていたものを，利用しないように変更 

（上位のモジュールにて，IBUFGを利用しているため） 
 

 

113 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 
第２回 ARC/CPSY/RECONF 高性能コンピュータシステム設計コンテスト 

The 2nd ARC/CPSY/RECONF  
High-Performance Computer System Design Contest  

MIPS Cross Compiler Setup Manual 
コンテスト実行委員会コアチーム 

Version 2014-08-17 

114 

Document P35 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

このドキュメント 

• リファレンスデザインに含まれるプロセッサは命令セットアーキテクチャとして，
MIPSを採用しています． 

• リファレンスデザインで実行するアプリケーションを生成するために，MIPSクロ
ス開発環境（クロスコンパイラなどを含む環境）が必要となります． 

• このドキュメントでは， MIPSクロス開発環境の構築方法を説明します． 
 
• 設計コンテストのWEBサイト 

– http://aquila.is.utsunomiya-u.ac.jp/contest/ 
 

• 不明な点は，以下のいずれかの方法でお問い合わせください． 
– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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コンパイル済みのMIPSクロス開発環境の設定方法 

• 幾つかのLinuxのためのMIPSクロスコンパイラのバイナリを準備しています． 
– このバイナリでは， buildroot-2009.08.tar.gz を利用しています． 
– RedHat5 x86版（64ビット），CentOS6.4 x86版（32ビット），

Ubuntu12.04 x86版（64ビット） のいずれかがインストールされたLinuxマ
シンの利用を推奨します．  
 

• お手軽に環境を構築するためには，使っているLinuxに最も近いバイナリをダ
ウンロード，展開します． 

• /home/share/cad/ というディレクトリを作成し，そこで，バイナリを展開し，
mipsel-contest というシンボリックリンクを作成します． 

• 具体的なコマンド例は次のスライドを参照してください．（コマンドの先頭には $ 
を追加しています．） 
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コンパイル済みのMIPSクロス開発環境の設定方法 

• RedHat Linux Version 5 (aquabase) 
– mips_procdesign_redhat5.tgz 

を次のURLからダウンロード http://aquila.is.utsunomiya-u.ac.jp/contest/ 
– $ cd /home/share/cad/ 
– $ tar xvfz mips_procdesign_redhat5.tgz 
– $ ln –s mips_proc_redhat5 mipsel-contest 
 

• CentOS release 6 (plumbase) 
– mips_procdesign_cent63.tgz 

を次のURLからダウンロード http://aquila.is.utsunomiya-u.ac.jp/contest/ 
– $ cd /home/share/cad/ 
– $ tar xvfz mips_procdesign_cent63.tgz 
– $ ln –s mips_proc_cent63 mipsel-contest 

 
• Ubuntu  12.04 LTS (gn001) 

– mips_procdesign_ubuntu1204.tgz 
を次のURLからダウンロード http://aquila.is.utsunomiya-u.ac.jp/contest/ 

– $ cd /home/share/cad/ 
– $ tar xvfz mips_procdesign_ubuntu1204.tgz 
– $ ln –s mips_proc_ubuntu1204 mipsel-contest 
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コンパイル済みのMIPSクロス開発環境の動作確認 

• $ /home/share/cad/mipsel-contest/usr/bin/mipsel-linux-gcc –v 
• コンパイラのバージョンなどが表示されることを確認してください． 

 
• 簡単なCのプログラム main.c を作成して次のコマンドを実行してください． 
• $ /home/share/cad/mipsel-contest/usr/bin/mipsel-linux-gcc –S main.c 
• コンパイルされて main.s というファイルが生成されます． 

 
• 補足 

– 提供しているバイナリには シミュレータ SimMips と，メモリイメージ作成のため
の memgen がインストールされています． 

– 以下のコマンドで正しく動作することを確認してください． 
– $ /home/share/cad/mipsel-contest/usr/bin/SimMips 
– $ /home/share/cad/mipsel-contest/usr/bin/memgen 
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MIPSクロス開発環境の構築方法 

• 先に説明したバイナリを用いることでお手軽にMIPSクロスコンパイラが利用で
きるようになります． 
 

• 自分でMIPSクロスコンパイラを構築したい場合には次のページを参考にしてく
ださい． 
– http://www.arch.cs.titech.ac.jp/mcore/buildroot.html 
– ただし， 

fakeroot_1.9.5.tar.gz が無いと言われてエラーになることがあるので，ダ
ウンロードして展開したディレクトリ下の dl というディレクトリに 
fakeroot_1.9.5.tar.gz をコピーして，再度 make してください． 
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リファレンスデザインのためのアプリケーション開発 

• リファレンスデザインのためのアプリケーションをコンパイルするためにSDK（ソ
フトウェア開発キット）を提供します． 

• ホームページから SDK-1.1.1.tgz というファイルをダウンロードし展開してくださ
い（バージョンアップによりファイル名が異なることがあります）． 

• 展開したディレクトリの README.txt に使い方の説明があります． 
 
– 設計コンテストのWEBサイト 

• http://aquila.is.utsunomiya-u.ac.jp/contest/ 
 

– 不明な点は，以下のいずれかの方法でお問い合わせください． 
– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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ソースコードは 

SDK-1.1.2を使用して下さい 
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このドキュメント 

• このドキュメントでは，4種類のアプリケーションプログラムの仕様を説明します 
 

• 設計コンテストのWEBサイト 
– http://aquila.is.utsunomiya-u.ac.jp/contest/ 

 
• 不明な点は，以下のいずれかの方法でお問い合わせください． 

– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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310_sort 

• 256KBのデータファイル 310sort.dat には，次の構造体で定義される，ソートすべきデ
ータを初期化するためのランダムデータと，ソートの要素数 n が格納されます． 

• このファイルの生成方法は， data.c と Makefile を参考にしてください．  
• iを自然数として，ソートの要素数 n = i * 1024 により指定されます．要素数 n の上限は

4M (データサイズ 16MB) です．  
 
 
 
 

 
 

• サンプルアプリケーションは main.c に記述されています． 
– まず，データファイルの値を用いて，配列 data を初期化します． 
– 確認のため，先頭の100要素の値を表示します． 
– 次に，qsort によりソーティングをおこないます．main.c ではクイックソートが実装さ

れていますが，任意のソーティングアルゴリズムを用いて修正しても構いません． 
– ソーティング後の値を適切にサンプリングして表示します． 

 
 124 

struct data_t { 
    unsigned int buf[SIZE-1];  // 256KB -4Byte buffer 
    int n;                     // the number of elements 
}; 
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320_mm 

• 256KBのデータファイル 320mm.dat には，次の構造体で定義される，行列を初期化す
るためのランダムデータと，行列サイズ n が格納されます． 

• このファイルの生成方法は， data.c と Makefile を参考にしてください．  
• iを自然数として，ソートの要素数 n = i * 16 により指定されます．行列サイズ n の上限

は 4096です．  
 
 
 
 

 
 

• サンプルアプリケーションは main.c に記述されています． 
– まず，データファイルの値を用いて，正方行列 a, b, c を初期化します． 
– 行列積 c = a x b を計算します． 
– 確認のため，c の一部の要素を表示します． 
– 確認のため，c の全ての要素の CRC32 を計算して表示します．（2014/8/27変更） 
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struct data_t { 
    unsigned int buf[SIZE-1];  // 256KB -4Byte buffer 
    int n;                     // matrix size 
}; 
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330_stencil 

• 256KBのデータファイル 330stencil.dat には，次の構造体で定義される，配列の初期化
のためのランダムデータと，配列サイズn ， イタレーション回数 iter が格納されます． 

• このファイルの生成方法は， data.c と Makefile を参考にしてください．  
• iを自然数として，ソートの要素数 n = i * 32,  iter = i *2 により指定されます．配列サイ

ズ n の上限は 4096 です．イタレーション回数 iter の上限は 100000 です．  
 
 
 
 

 
 

• サンプルアプリケーションは main.c に記述されています． 
– まず，データファイルの値を用いて，配列 buf1, buf2 を初期化します． 
– それぞれの要素の自分自身を含む9近傍の平均により，次のイタレーションの値を計

算します．配列間のコピーを排除するため， buf1, buf2 を相互に更新する手法を採
用しています．ある要素は常に 0x9999999 の値を保持するものとしています． 

– 計算終了後，確認のため，一部の要素を表示します． 
– 確認のため，全ての要素の加算（オーバフローは無視）の結果を表示します． 
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struct data_t { 
    int buf[SIZE-2];  // 256KB -4Byte buffer 
    int n; 
    int iter; 
}; 
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340_spath：最短路問題の概要 

• 概要 
– 与えられたグラフ上の，指定された2点間の最短距離を求める問題です． 
– グラフ・問題定義は，ファイル（.gr, .p2p）にて定義されています． 

• 問題のグラフは，最短路がただ一つ存在することが保証されています． 
【第１回からの追加点】 

 
• グラフ・問題定義の出典に関する情報 

– グラフ・問題定義は，9th DIMACS Implementation Challenge - 
Shortest Pathsにて用いられた，ランダムグラフ生成ツールを用いて作り
ます． 

• 生成ツール類は，パブリックドメインのソフトウェアとして配布されています． 
– http://www.dis.uniroma1.it/challenge9/download.shtml 

– グラフ・問題定義のファイル形式の情報は以下のURLからご確認ください． 
• http://www.dis.uniroma1.it/challenge9/format.shtml 
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340_spath：入力データと実装の概要 

• 256KBのデータファイル 340spath.dat には，次の構造体で定義される，対象グラフのノ
ード間接続（エッジ）を表すデータ(buf)と，ノード数 n ，エッジ数m ，始点ノード番号start
，終点ノード番号 goalが格納されます．n は2のべき乗，m は n の倍数です．ノード数 n 
の上限は 2048 です．エッジ数 m の上限 は 8192 です．  

• このファイルの生成方法は， generator.rbと Makefile を参考にしてください．  
 
 
 
 
 
 
 

• 入力ファイルのエッジのデータは，1つのエッジあたり3ワードで構成されます． 
詳しくは，「340_spath：データ形式について」のスライドを見てください． 

• アルゴリズムは main.cに記述されています． 
– メインの関数では，データの初期化後にfindShortestPath関数を呼びます． 
– findShortestPath関数は，Dijkstraのアルゴリズムにより最短路を求めます． 
– 最後に最短ルートのノード番号を順番に表示し，コスト（距離）の合計を表示します． 
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struct data_t { 
    unsigned int buf[SIZE-4];  // 256KB -16(4x4)Byte buffer 
    int n;                     // the number of nodes 
    int m;                     // the number of edges 
    int start;                 // ID of the start node 
    int goal;                  // ID of the goal node 
}; 
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340_spath：データ形式について 

• エッジのデータ形式（入力データ） 
– エッジのデータは次の構造体で表さ

れます．1つのエッジあたり3ワード（
12バイト）で構成されます． 

– 入力データのbufはedgeの配列に
なります． 

– fromとtoはそれぞれ始点・終点の
ノード番号です． 

– costはノード間の距離（整数値）で
す． 

• ノードのデータ形式（内部データ） 
– ノードのデータは次の構造体で表さ

れます．1つのノードあたり3ワード（
12バイト）で構成されます． 

– Dijkstraのアルゴリズムを想定し
ています． 

– currentCostはノードの現在のコス
ト（合計値）です． 

– isMinimumCostは，TRUE(1)か
FALSE(0)で最小コストであること
が確定していることを示します． 

– fromNodeForMinimumCostは、

最小コスト（最短路）となる場合の，
直前のノード番号を保持します． 
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typedef struct { 
  int from; 
  int to; 
  int cost; 
} edge; 

typedef struct { 
  int currentCost; 
  int isMinimumCost; 
  int fromNodeForMinimumCost; 
} node; 
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340_spath：ファイルの説明（生成ファイルを含む） 

• バイナリ 
– 340spath       －シミュレータ用実行バイナリ（elf） 
– 340spath512.bin －FPGA用バイナリ(512KB) 
– 340spath.bin   －FPGA用バイナリ コード部分のみ(256KB) 
– 340spath.dat   －入力データ(256KB), data.binも同じもの 

• スクリプト 
– Makefile      －デフォルトでFPGA用バイナリ(512KB)を生成 
– generator.rb  －グラフ・問題定義ファイル（.gr, .p2p）から、データファイルを生成 
– sim.m   －シミュレーションでデータを読み込むための定義 

• ソースファイル 
– main.c        －メイン関数と最短路問題に関する実装 
– startup.S   －ブートアップコード 

• データファイル 
– n2048.gr        －グラフ定義ファイル （2048ノード） 
– n2048.p2p      －問題定義ファイル（始点・終点の指定） 
– n6.gr         －【参考】単純なグラフ定義ファイル （6ノード） 
– n6.p2p        －【参考】問題定義ファイル（始点・終点の指定） 
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このドキュメント 

• このドキュメントでは，コンピュータシステム部門のアプリケーションプログラム
の仕様を説明します 

• また、SDKの使用方法について解説します． 
 

• 設計コンテストのWEBサイト 
– http://aquila.is.utsunomiya-u.ac.jp/contest/ 

 
• 不明な点は，以下のいずれかの方法でお問い合わせください． 

– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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コンピュータシステム設計部門のターゲット 
「ネットワーク画像オプティカルフロー処理」 

• 目的 
– ホストPCから送られる２つの画像フレーム間の動きベクトルを、オプティカ

ルフロー処理により計算し、画像に書き入れてホストPCに送り返す。 
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FPGA 
board 

HOST PC 

入力画像 
 （YCrCb成分をJPEGに似た形式で圧縮） 

① ② 

①→② 

出力画像 （RGB成分を同様の形式で圧縮） 
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概要 

• コンピュータシステム部門では，以下の処理をFPGAボードで行います 
– ホストから2つの入力画像フレーム（32KB x 2）を受け取り、デコードする 

• 画像は独自のJPEGに似た形式で圧縮されたフォーマットで渡されます． 
– 2つのフレーム間のオプティカルフローを計算する 

• オプティカルフローを画像に書き入れる（赤線） 
• 結果画像をエンコードして結果画像フレームにする 

– 結果画像フレーム（max64KB）をホストに送信し、更に”END”（1KB）を送信 
• 注意）UDP・シリアル変換のexStickBridgeは1KB単位でのみパケットを送信 

 
• 参考文献[1] 

– 昌達 慶仁 著，「詳解 画像処理プログラミング」，ソフトバンククリエイティブ
株式会社，2008． 
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FPGA・ホストPC間の通信シーケンス 
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main() 
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FPGA・ホストPCの処理フロー 
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ホストPCでの前処理内容 

• ２つの入力画像（410_tux0.bmp， 410_tux1.bmp ）をそれぞれYCrCb変換し
，その変換後の画像をJPEG圧縮します． 
– 読み込み可能なBMP画像フォーマットについては，参考文献[1]を参考にし

て下さい 
– YCrCb変換に関しては参考文献[1]にある手法をベースに整数化したバー

ジョンを使用しています．（参考文献[1]では浮動小数点を用いています） 
– YCrCb変換後の画像フォーマットとしては，BMP画像フォーマットのR部分

にY，G部分にCr，B部分にCbを格納して保存しています 
– JPEG圧縮に関しては，参考文献[1]では１要素（RGBならRのみ，今回の場

合Yのみ）に対しての圧縮処理でしたが，YCrCbそれぞれに対して圧縮処
理をするように改良しています． 

– JPEG圧縮では，参考文献[1]では浮動小数点のDCTが使われていました
が，整数化したDCTに変更しました． 

• ２つの入力画像をそれぞれ32KBのサイズに揃えます（0で埋める） 
• ２つをあわせて64KBのデータとし、UDP/IP(8100番ポート)で送信します． 

– 送信したデータは、ToUDP.（画像データ名）.binとして保存されます 
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FPGAでの処理内容 

• FPGAでは以下の処理をします． 
– 32KBの２つのデータを受信 
– ２つのJPEG圧縮画像（img0, img1）をデコード 
– デコードされた画像のそれぞれY, Cr, Cb成分を用いて，オプティカルフロ

ーを求めます． 
– 最初の入力画像（img0）に対してYCrCb->RGB変換（関数名は

convert2bmp）をし，RGB画像を得て，そのRGB画像に対してオプティカル
フローの線を描画します 

– オプティカルフローが描画された画像をJPEG圧縮します 
– 最大64KBの結果画像データを送信し，最後に”END”を送る 
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ホストでの後処理内容 と 時間計測・結果検証 

• FPGAからJPEG圧縮された画像をUDP/IP経由で受け取り，ファイルに保存し
ます．ファイル名：FromUDP.(画像データ名).binとして保存します． 

• 上記ファイルをデコードし，RESULT.(画像データ名).bmpとして保存します． 
• 正しいデータと一致しているか確認します． 

 
• 競技の時間計測について 

– ホストPCにおいて、以下のT2-T1の経過時間を計測します 
• T1: UDPにて64KBの画像データを送信 
• T2: UDPにて”END”を受信 

– その後、BMP画像データが、リファレンスデザインの結果BMP画像データと
完全一致しているかを検証します 
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コンピュータシステム設計部門 
リファレンスデザインSDKの 
使用方法 

• コンテストWEBサイトから、コンピュータシステム設計部門のリファレ
ンスデザインSDK（400_oflow_v10.tgz）をダウンロードして展開。 

• 開発環境： LinuxもしくはCygwin 
• http://aquila.is.utsunomiya-u.ac.jp/contest/toolkit.html 
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開発環境 

• ホストPC 
– OS： Windows7 

• 動作確認済みのホストPC上のソフトウェア環境 
– java version "1.7.0_60“ 

• 既知の問題： CentOS6.5をホストPCとして用いた際に，UDP通信が失敗する
事が報告されています。 
 

• exStickBridgeでの動作確認済みスイッチ一覧 
– BUFFALO LSW3-TX-5EPL 
– BUFFALO BSL-WS-G2116M 
– （今後追加します） 
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SDKの使い方 (1) ディレクトリ構成 

• ディレクトリ構成の簡単な説明です． 
– common : 共通ソースファイル 
– xilinx : Xilinx用ソースファイル 
– altera : Altera用ソースファイル 
– linux  : Linux用ソースファイル 
– client : ホスト用クライアントプログラムのディレクトリ 
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主なソースファイルの構成 

ディレクトリ ファイル名 概要 

Platform 
(linux, 
xilinx, 
altera) 

addressmap.h 
addressmap.c 

アドレスマップ 

communication.h 
communication.c 

ホストとの通信 

platform.h 
platform.c 

プラットフォーム固有の処理 

bmp.h, bmp.c ビットマップファイル関連(linuxのみ) 

Common codec.h 
codec.c 

Codecその他画像の変換関連のライ
ブラリ 

fileio.h 
fileio.c 

メモリファイル入出力 
（stdioのFILE置き換え） 

image.h, image.c 画像関連ライブラリ 

main.c メイン 

oflow.h, oflow.c オプティカルフロー関連処理 
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ユーティリティツール一覧 

ディレクトリ ファイル名 概要 

Linux decoder.c デコーダ 

encoder.c エンコーダ 

make32KBdata.c 32KBデータ作成 

rgb2ycbcr.c RGB→YCrCb色変換 
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SDKの使い方 (2) Linuxプログラムの動作確認-１ 

• FPGAボードが無くても，リファレンスデザインの機能を確認することが出来ます 
• トップディレクトリでのmake コマンドにより，FPGAボードでの動作を模擬する

Linux上で動作するプログラムを作成することが出来ます． 
 

• 出来上がる主なファイルは次の通りです． 
– 400_oflow      : Linux用のオプティカルフロー処理プログラム 
– encoder        : BMPファイルのJPEG風エンコーダ 
– decoder        : BMPファイルのJPEG風デコーダ 
– rgb2ycbcr      : BMPファイルの色変換(RGB -> YCrCb) 

• トップディレクトリで，以下のコマンドにより400_oflowプログラムを起動します． 
 

• 以下の様に、ホストプログラムからの画像データを待ち受ける状態になります． 
– UDP/8100ポートにて32KBバイトの画像データ２セットを待ち受けます． 
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$ ./400_oflow 
Starting 400_oflow (batchID:410) === 
Waiting recv 32KB at 0906c008 

$ make 

$ ./400_oflow 
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SDKの使い方 (2) Linuxプログラムの動作確認-２ 

• 次に，別ウィンドウを開き，以下のコマンドでホストプログラムを起動します． 
 
 

• all.shは画像データセットを送るスクリプトを４つ順次起動します． 
– (410_tux.sh, 411_anim.sh, 412_star.sh, 413_rectangle.sh) 
– この際，スクリプトの内部では，javaのUDP送信プログラムを起動します． 
– all.shスクリプトの引数には，UDPパケットの送信先IPアドレスを指定可能 
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$ ./all.sh 
targetHost:127.0.0.1 targetPort:8100 
UDP Socket created. sending file '410_tux.64KB' 
started! 
64KB sent 
 
finished! 
after-before = 3331318965 (ns) = 3.331318965(s) 
（続く） 

$ cd client 
$ ./all.sh 
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SDKの使い方 (2) Linuxプログラムの動作確認-３ 

• 正しく動くと、4回のオプティカルフロー計算処理が走ります。 
• 結果は、ホストPC側（クライアント側）にRESULT.***.bmpファイルとして保存さ

れます。 
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410_tux 

411_anim 

412_star 

413_rectangle 
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SDKの使い方 (3) Xilinx/Altera FPGAボード向け 
ソースファイルのexport方法 

• FPGAボード上で動作するソフトウェアのソースファイルをexportするには，以
下の様にします。 
 
 

• exportディレクトリ以下に、xilinx/srcディレクトリとaltera/srcディレクトリが出
来ますので、その中の.cファイル・.hファイルを，Xilinx MicroBlaze環境もしく
はAltera Nios2環境にコピーして使用してください。 
 

• 以降は，別ドキュメントにて，Xilinx/Altera環境での動作方法について説明し
ます． 
– P61 Xilinx環境 
– P62 Altera環境 
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$ make export 
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SDKの使い方 (4) 既知の問題 

• 現在のリファレンスデザインには，以下に挙げる問題があることが分かっていま
す．注意してお使いください． 
– 元画像(BMP)をエンコードし，デコードすると元画像に戻らない場合がある

．（特に画像サイズが大きい場合） 
– ホストPCとしてCentOS6.5の環境とFPGAボードの間でUDP通信を行った

場合に、途中で停止することがある。（Atlysボード・DE2-115ボードいずれ
の場合においても不具合が発生する様子。・現在調査中） 
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このドキュメント 

• このドキュメントでは，Atlysボード用のリファレンスデザインに含まれるシステ
ム構成について説明します． 

• また，Xilinx Platform Studio (ISE14.7)を用いて，リファレンスデザインの回
路ファイル（bitファイル）を生成し、プログラムしたFPGA上で400_oflowソフト
ウェアを動作させる方法を示します． 

 
• 設計コンテストのWEBサイト 

– http://aquila.is.utsunomiya-u.ac.jp/contest/ 
 

• 不明な点は，以下のいずれかの方法でお問い合わせください． 
– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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最初に 

• 開発環境については、ドキュメントP30を参考にしてください。 
 

• Xilinx版とAltera版は機能的には同じですが，異なる所が多々ありますので，
注意して下さい． 

• Xilinx版のリファレンスデザインは，ISE14.7のEDK Xilinx Platform Studio
で開発できます．ISE WEB Packでは開発できませんのでご注意ください． 

• 大学関係者であればXilinx University ProgramのISEライセンス申請が可能
です． 
– http://japan.xilinx.com/support/university.html 

• またISEの無償評価版ライセンスがXilinxのホームページより申請可能です． 
– http://japan.xilinx.com/ise_eval/index.htm 

http://japan.xilinx.com/support/university.html
http://japan.xilinx.com/ise_eval/index.htm
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リファレンスデザインAtlys-oflowのブロック図 

Axi_ 
ploader_ 

uart 

MicroBlaze 
I$8KB 
D$8KB 

BRAM 
(32kB) 

SDRAM 
Interface 

RS232C
_Uart 

AXI 
Atlys-oflow 

SDRAM 
(128MB) 

UART(1Mbps) 

Debug_
module 

JTAG exStickBridge 

UDP/IP 
(100M ethernet) 

LMB 

UART 
(115.2Kbps) 
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システム構成の概要 

• 本システムの構成は、Digilent社のWEBサイトにて提供されている，”Atlys 
board support files for EDK BSB wizard”を用いて作製しました． 
– http://www.digilentinc.com/ 

 
• 構成要素 

– MicroBlazeソフトコアプロセッサ 
• 設定）浮動小数点なし，32ビット乗算器搭載，I$8KB，D$8KB 

– Block RAM (BRAM) 32KB 
– SDRAM I/F (128MB) 
– MicroBlaze Debug Module (MDM) – JTAGによるデバッグ接続 
– RS232C_Uart  

• AtlysボードのUART-USB変換用のシリアル通信（115.2Kbps） 
– Axi_ploader_uart 

• 本コンテスト用のシリアル通信(1Mbps)  
→ PMODコネクタ経由でexStickBridgeに接続 
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メモリマップ 

メモリアドレス 
開始アドレス 終了アドレス 

0x0000_0000 0x0000_7FFF Block RAM (on-chip) 
0x4060_0000 0x4060_FFFF RS232_Uart  

(115.2kbps USB-UART) 
0x77A0_0000 0x77A0_FFFF Axi_ploader_uart 

(1Mbps UART via PMOD) 
0xA800_0000 0xAFFF_FFFF SDRAM (128MB) 
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コンピュータシステム設計部門 
ATLYSボード用ハードウェアリファ
レンスデザインの使用方法 

• コンテストWEBサイトから、コンピュータシステム設計部門のXilinx 
FPGA – Atlysボード用のリファレンスデザイン 
Atlys-oflow_v02.zipをダウンロードして展開します。 
• 展開先例） C:¥workspace-edk147¥Atlys-oflow 
• http://aquila.is.utsunomiya-u.ac.jp/contest/toolkit.html 
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ハードウェアセットアップ 

• Windows 7 マシン と Atlysボード を２本の USBケーブル で接続 
• FPGAボード用電源 を使ってAtlysボードに電源供給 
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USBケーブルで接続 
FPGAコンフィギュレーション用 

USBケーブルで接続 
シリアル通信用 （115.2Kbaud） 

FPGAボード用電源 

Atlysボード 

Windows 7 マシン 

• 注意点 
– AtlysボードにはUSBケーブルが１本しか添付されていません．別途 1本のUSBケーブル

（Aコネクタ-マイクロBコネクタ）を準備してください． 
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準備 USB-UARTドライバのインストール 

• Windows 7 マシンにUSB-UARTドライバをインストール 
– http://www.exar.com/connectivity/uart-and-bridging-

solutions/usb-uarts/xr21v1410 
• Software Drivers Windows 2000, XP, Vista, 7, and 8 Drivers 

Version 2.0.0.0 August 2013 
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ソフトウェアセットアップ Tera Term のインストール 

• Windows 7 マシンに Tera Termをインストール 
– http://sourceforge.jp/projects/ttssh2/ 
–  teraterm-4.78.exe 

 

160 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

Tera Term の設定 （１） 

• ATLYSをコンピュータに接続し，COMポートが見えることを確認 
– Windows の デバイス マネージャー から確認 
– ポート番号(COM5)はコンピュータによって異なります． 

 
 
 

 
• Tera Term を立ち上げる（シリアル ポートを選択） 
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Tera Term の設定 （２） 

• Tera Termのシリアル設定を 115.2Kbaud に変更します． 
– 設定 -> シリアルポート -> ボー・レート 

115200を選択して， OK をクリック． 
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Xilinx Platform Studio (XPS)の起動とExport 

• ISE Desugin Suite 14.7 → EDK → Xilinx Platform Studioを起動
し、Atlys-oflow/system.xmpを開く 
– 以下、C:¥workspace-edk147¥Atlys-oflowに配置したとする 

• 以下の画面になるので、”Export Design”をクリック 
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Export to SDK, XSDKの起動 

← Export & Launch SDKをクリック 
＜HDL生成・合成・配置配線・ビットス
トリーム生成に約20分程度かかる＞ 
↓その後、以下の画面が出るので、 
プロジェクトディレクトリの下の、
”SDK/SDK_Export”ディレクトリを指
定する。 
例） C:¥workspace-edk147¥Atlys-
oflow¥SDK¥SDK_Export 

164 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

Xilinx SDKの起動 

• 以下のような画面が現れるはず 
• 次ページ以降は、リファレンスデザインのSDK(400_oflow_v02.tgz)

からexportした.c, .hファイルを用いてアプリケーションを作成する方法
を説明する。 
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アプリケーションプロジェクトの作成 (1/3) 

• メニューFile→New..から、Application Projectを選択 
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アプリケーションプロジェクトの作成 (2/3) 

• プロジェクト名を設定（例：400_oflow） 
– Nextをクリック 

• 次の画面で、Empty Projectを選択 
– Finishをクリック 
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アプリケーションプロジェクトの作成 (3/3) 

• SDK(400_oflow_v02.tgz)からexportした.c, .hファイルをコピー(Ctrl+C) 
• XSDKの400_oflowプロジェクトのsrcディレクトリをクリックした後に、ペースト

(Ctrl+V) 
– Drag&DropでもOK 

• 自動的にビルドが始まる 
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コピー＆ 
ペースト 

400_oflow¥export¥xilinx¥src 
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JTAGケーブル設定＆FPGAプログラム 

• ①JTAGの設定をします。右のWindowが出るのでDigilentを選択 
• ②Program FPGAして下さい。 

– 次のWindowでProgramをクリック 
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デバッグ用シリアルコンソールの接続(TeraTerm) 

• プログラム実行前にTera Termにて、シリアルコンソールを立ち上げておきま
す。 
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プログラムの実行 

• プロジェクトを右クリックし 
• Run Asのメニューを選び 
• Launch on Hardware  

(GDB)をクリックしてください 
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400_oflowの起動 

• Starting 400_oflow・・・という 
起動メッセージが表示されるはず 
– 表示されない場合は 

ここまでの作業を再確認 
• 32KB＋32KBの画像データを 

UDP/8100番ポートで 
待ち受けています 
（exStickBridge経由） 
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ホストPCでのUDP通信プログラムの起動 

• ホストPCにて、画像データを用意し、UDPによりFPGAに転送する必要がありま
す。 

• リファレンスデザインのSDK(400_oflow_v02.tgz)を、ホストPCに展開し、
clientディレクトリにて、all.shスクリプトを動かします。（IPアドレスを指定） 

new UDP_Client 
(“imageset1.64KB”) 

.run() 

FPGA ホストPC 
imageset1.64KB 

nextFrame() 
“END”(1KB) 

decode() decode() 
oflow1 (max64KB) optical_flow() 

encode() 

$ ./all.sh 192.168.10.64 
targetHost:192.168.10.64 targetPort:8100 
UDP Socket created. sending file '410_tux.64KB' 
started! 
64KB sent 
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スタック領域の設定 (1/2) 

• しかし、最初の画像を読み込んだ後、止まってしまうかもしれません。 
– XSDKのデフォルトでは、スタック領域が1KB(0x400)バイトしかありません

ので、上手く動きません。 
• スタック領域の大きさを設定するには、 

プロジェクトを右クリックして、Generate Linker Script 
を選択します 
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スタック領域の設定 (2/2) 

• Generate Linker Scirptダイアログで、例えば以下の設定をします。 
– CodeSectionの配置: DDR2 
– DataSectionの配置：DDR2 
– Heap&Stackの配置：bram 
– HeapSize: 1 KB 
– StackSize: 16 KB 

• その後、Generateすると 
Overwriteするか聞かれる 
のでlscript.ldファイルを 
更新します。 
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400_oflowの動作確認 

• さて、動くでしょうか・・・？400_oflowプロジェクトを右クリックして、Runします 
• ホストPC用のクライアントも再度動かしてください。($ ./all.sh 192.168.10.64) 
• Linux上で動作させたときと同じ様にRESULTのBMPファイルが出来ればOK！ 
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The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 
第２回 ARC/CPSY/RECONF 高性能コンピュータシステム設計コンテスト 

The 2nd ARC/CPSY/RECONF  
High-Performance Computer System Design Contest  

User Manual of Optical Flow System 
Reference Design (Altera DE2-115) 

コンテスト実行委員会コアチーム 
Version 2014-07-28 

177 

Document P62 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

このドキュメント 

• このドキュメントでは，Altera DE2-115ボード用のリファレンスデザインに含ま
れるシステム構成について説明します． 

• また，Altera Quartusを用いて，リファレンスデザインの回路ファイル（sofファ
イル）を生成する方法を示します． 

 
• 設計コンテストのWEBサイト 

– http://aquila.is.utsunomiya-u.ac.jp/contest/ 
 

• 不明な点は，以下のいずれかの方法でお問い合わせください． 
– メールアドレス(contest_support@virgo.is.utsunomiya-u.ac.jp) 
– twitter(#arc_procon) 
– 技術情報掲示板 

• Google Group: HpCpsyDC2014 
• https://groups.google.com/forum/?hl=ja#!forum/hpcpsy2014dc 
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最初に 

• Altera版ContestSysはXilinx版と機能的には同じですが，異なる所が多々あ
りますので，注意して下さい． 

• Altera版のリファレンスデザインは，Quartus Web Editionで開発できるよう
に考慮しております．そのため，Nios2の実装にはNios2/eを使用し，キャッシ
ュ等は搭載しておりません． 

• 大学関係者の方はAcademic License（無料）がAlteraのホームページより申

請可能ですので，利用される事をお勧め致します．以下，簡単に手順方法を記
載しておきます． 
1. AlteraのUniversity Program（

http://www.altera.com/education/univ/unv-index.html）のページの
左にあるメニューの中の，Member->License Requestをクリックする 

2. myAlteraのアカウント名，パスワードを入力して，申請ページへ行く． 
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リファレンスデザインContestSysのブロック図 

Contest 
UART 

Nios II/e On-chip 
Memory 
(256kB) 

SDRAM 
Interface 

PLL 

nios2_sys 

ContestSys 

SDRAM 
(128MB) 

UART 

JTAG 
UART 

USB Blaster 

exStickBridge 

UDP/IP 
(100M ethernet) 
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各機能の役割 

• PLL 
– 50MHzのクロックを供給 

• On-chip Memory（256kB） 
– 命令メモリとして使用 

• SDRAM 
– NiosIIの命令メモリ，データメモリとして使用． 

• Contest UART 
– データ転送用のインターフェース． 
– UARTから受信したデータを32ビットのデータとして格納する． 
– 8ビットのデータをUART経由で送信する 

• JTAG UART 
– NiosIIでの実行経過などをprintfで出力するインターフェース 

• NiosII/e 
– オプティカルフローを計算するCPU 
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Contest UARTの詳細 
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Contest UART 
 avalon interface 

avalon bus 

UART RX to char 

char to int UART TX  
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Contest UARTの詳細 

• contest UART avalon interface 
– UART RXやUART TXに対してavalonバスとのinterfaceになる 

• char to int 
– UART RXを8ビットのデータにしたものを32ビットのデータに変換する 

• UART RX to char 
– シリアルで入力されるUART RXのデータを8ビットのデータに変換する 

• UART TX 
– 8ビットのデータをシリアルで送信する 

183 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

メモリマップ 

メモリアドレス 
開始アドレス 終了アドレス 

0x0000_0000 0x0003_FFFF on-chip memory 
0x0004_1020 0x0004_102f Contest UART 
0x0005_0000 0x0005_07FF Nios II/e 
0x0800_0000 0x0FFF_FFFF SDRAM 

補足 
• SDRAMの領域は0x0800_0000番地から使用出来るのですが， 

リファレンスデザインでは0x0c00_0000番地から使用しています． 
（SDRAM領域の0x0800_0000番地からの領域をデバッグに用いていたため） 
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リファレンスデザインの作成について 

• 次ページ以降で作成するリファレンスデザインの作成方法では，Verilog-HDL
の記述は既に完成しているものを使用するとします． 

• 本ドキュメントで参照するファイルは以下のものです． 
– ContestSys05.tar.gz 

• DE2-115ボード用コンピュータシステム設計部門リファレンスデザインのプロジ
ェクトファイル 

– DE2-115.qsf 
• DE2-115ボード用ピン設定ファイル．下記のURLから取得できます 

http://www.altera.com/education/univ/materials/boards/de2-115/unv-
de2-115-board.html 
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ハードウェアデザイン 
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新規プロジェクトの作成 

1. プロジェクトを置くディレクトリは新規に空のディレクトリを作成する．ここでは
ContestSys06とします 

2. 新規に作成したディレクトリでQuartus を起動する 
3. File -> New Project Wizardを選択 

1. プロジェクト名をトップモジュール名（ContestSys）にする（次ページ左写真）． 
その後Next 

2. Add fileでは何も追加しない 
3. デバイス名はCyclone IV E EP4CE115F29C7を選ぶ（次ページ右写真） 
4. EDA toolの設定でSimulationツールとしてModelsimを選んでいる場合は

FormatをVerilog HDLにする 
5. その他はデフォルトでNextを押し，finishまでいく 
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新規プロジェクトの作成 
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Name filterでデバイス名の候補を 
filteringできる 
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Qsysの起動と外部クロックの設定 

• ここではQsysのシステムとしてnios2 sysを作成します． 
• Tools -> QsysでQsysを起動する 

（以下Qsysでの操作です．） 
• File -> Save でnios2_sysという名前をつけて保存 
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PLLの追加 

• Library から PLL -> Avalon PLL を選択し，Add 
• 現れたWindowで以下を設定 

– Parameter Setting -> General/Mode内の入力クロックを50MHzに設定 
（次ページの画面1） 

– Output Clock -> clk c0のEnter output clock frequencyのラジオボタン
を選択し，50MHzと入力（次ページの画面2） 

– Output Clock -> clk c1のEnter output clock frequencyのラジオボタン
を選択し，50MHzと入力し，Clock phase shiftを-3nsとする．（2ページ先
の画面3） 

– Finishボタンを押す 
• 追加したPLLの名前をpllに変更 
• PLLの配線を以下の用にする 

– pllのclk_in_primaryとclk_0のclkを接続 
– pllのclk_in_primary_resetとclk_0のclk_resetを接続 

• PLLのc1をexport欄をダブルクリックしてexportし，export名をsdram_clkと
する 

• PLLのlocked_conduitのexport欄をダブルクリックしてexportし，export名を
lockedとする（2ページ先の画面4） 
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PLLの追加 
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画面1 

ここの欄が現在設定している 
項目を示すタブになっている 

画面2 
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PLLの追加 
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画面3 

画面4 
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PLLの設定 

• 追加したPLLの名前をpllに変更 
• PLLの配線を以下の用にする 

– pllのclk_in_primaryとclk_0のclkを接続 
– pllのclk_in_primary_resetとclk_0のclk_resetを接続 

• PLLのc1をexport欄をダブルクリックしてexportし，export名をsdram_clkと
する 

• PLLのlocked_conduitのexport欄をダブルクリックしてexportし，export名を
lockedとする 
 

193 



The 2nd ARC/CPSY/RECONF High-Performance Computer System Design Contest 

SDRAM Controllerの追加 

• Library から Memories and Memory Controllers->External Memory 
Interfaces-> SDRAM Interfaces -> SDRAM Controllerを選択し，Add 

• 現れたWindowで以下を設定する 
– Data Width: 32 
– Address Width 

• Row: 13，Colum: 10 
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SDRAM ControllerのTiming設定 

• Timingタブをクリック 
– Issue one refresh command every を7.8125us 
– Delay after powerupを200us 

• Finishボタンをクリック 
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SDRAM Controllerのclk配線など 

• 追加したsdram controllerの名前をsdramに変更（
new_sdram_controller_0という名前の上で右クリックを押して現れるメニュー
からRenameを選択） 

• pllのc0をsdram controllerのclkに配線 
• clk_0のclk_resetをsdramのresetに配線 
• sdramのwireをExportするようにExport欄をダブルクリック．（Export名を 

sdram_wireとする） 
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On-Chip memoryの追加 

• Library から Memories and Memory Controllers-> On-Chip -> On-Chip 
Memory(RAM or ROM)を選択し，Add 
– Total Memory Sizeを262144とする(256k) 
– Finishをクリックする 

• 名前をonchip_memoryに変更 
• onchip_memoryのclk1をpllのc0と接続する 
• onchip_memoryのreset1をclk_0のclk_resetと接続する 
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JTAG UARTの追加 

• Library から Interface Protocols-> Serial -> JTAG UARTを選択し，Add 
– Finishをクリックする 

• 名前をjtag_uartに変更 
• jtag_uartのclkをpllのc0と接続する 
• jtag_uartのresetをclk_0のclk_resetと接続する 
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contest uart avalon interfaceをComponentとして登録 

• ProjectのNew Componentを選択して，Add 
• Component Typeタブ内 

– Name, Display Nameを”contest_uart_avalon_interface”とする 
– Groupを”My Own IP Core”とする 

• Filesタブ内 
– （プロジェクトディレクトリ内にリファレンスデザインのプロジェクトディレクトリ

にある以下のファイルをコピーしておく 
• contest_uart_avalon_interface.v 
• system.v 
• define.v 

– Synthesis Filesとして，define.v以外の上記2つのVerilog HDLファイル
を追加する（contest_uart_avalon_interface.vがTop-level Fileとなって
いるのを確認） 

– Analyze Synthesis Filesボタンをクリック 
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contest uart avalon interfaceをComponentとして登録 

• Signalsタブ内 
– clockのinterfaceの所を選択して，new Clock Inputを選択し，interface

欄がclock_sinkとなるようにし，Signal Typeをclkとする 
– resetのinterfaceの所を選択して，new Reset Inputを選択し，

interface欄がreset_sinkとなるようにする． 
• Interfaceタブ内 

– Remove Interfaces With No Signalsボタンを押す 
– s1のAssociated Clockをclock_sinkに，Associated Resetをreset_sink

にする 
– conduit_end_0のAssociated Clock, Associated Resetも同様にする 
– reset_sinkのAssociated Clockをclock_sinkにする 

• Finishボタンを押し，保存するかどうかを訪ねるWindowが出たら，Saveを選ぶ
． 
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contest uart avalon interfaceを追加 

• ProjectのMy Own IP Core内のcontest_uart_avalon_interfaceを選択して
Add 
– Finishボタンをクリック 

• 名前をcontest_uartに変更 
• contest_uart_avalon_interfaceのclock_sinkをpllのc0と接続 
• contest_uart_avalon_interfaceのreset_sinkをclk_0のclk_resetと接続 
• contest_uart_avalon_interfaceのconduit_end_0のexport欄をダブルクリ

ックして，export名をexportとする 
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Nios II/eの追加 

• Library から Embedded Processors-> Nios II Processorを選択し，Add 
– Nios II CoreとしてNios II/eを選択する 
– Finishをクリックする 

• 名前をnios2に変更 
• nios2のclkをpllのc0と接続する 
• nios2のreset_nをclk_0のclk_resetと接続する 
• nios2のdata_masterをcontest_uartのs1，jtag_uartのavalon_jtag_slave

，onchip_memoryのs1，sdramのs1と接続する 
• nios2のinstruction_masterをonchip_memoryのs1，sdramのs1と接続する 
• nios2のIRQとjtag_uartのIRQを接続する 
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NiosII/eの追加 
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nios2の設定 

• nios2を選択して，右クリックし，Editを選択する 
• Reset vector memoryとException vector memoryとして，

onchip_memory.s1を選択する 
• Finishボタンをクリック 
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メモリマップの作成 

• メモリマップとしてbase addressを以下のように指定して，ロック 
– sdramのmemory: 0x0800_0000  
– onchip_memory:0x0000_0000 
– contest_uart: 0x0004_1020 
– nios2: 0x0005_0000 

• jtag_uartはどこに割り当ててもよいので，System->Assign Base Addressで
割り当てる  
 

ロックを外した状態で 
アドレスを入力し， 
その後ロックをかける 
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nios2_sysの生成 

• メニューSystem -> Create Global Reset Networkをクリック 
• この時点で，Qsys下部のMessageからエラー表示がなくなっているはず 
• mips_sysを保存 
• メニューGenerate -> Generateをクリック 

– Generateボタンをクリック 
• ちなみに，mips_avalon_interface.vなどを変更する度に，QsysでGenerate

する必要があります 
• 以上で，Qsysは終了してOK 

Generateでは 
右下のGenerateボタンを 
押すだけでよい 
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プロジェクトへのファイルの追加 

• あらかじめ，ContestSys.vをプロジエクトディレクトリにコピーしておく 
• Porject -> Add/Remove files in Projectで以下のファイルを追加する 

– ContestSys.v 
– nios2_sys.qsys 

• 追加したらOKボタンを押してウィンドウを閉じる 

ここをクリックして追加するファイルを選択し，その後addボタンを押す 
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ピン配置情報のimportと割当 

• Assignments -> Import Assignmentsをクリック 
– DE2_115.qsfを選択し，importする 

• Assignments -> Pin Plannerをクリック 
– 現れるウィンドウの下の方にある各ピンの設定で，GPIO[3]のI/O 

Standardを3.3V LVCMOSにする 
– 同様に GPIO[5], GPIO[7], GPIO[9]も同様に変更する 
– メニューFile -> closeをクリックして，ウィンドウを閉じる 

Node Name Location I/O Standard 

GPIO[3] PIN_Y17 3.3V LVCMOS 
GPIO[5] PIN_Y16 3.3V LVCMOS 
GPIO[7] PIN_AE16 3.3V LVCMOS 
GPIO[9] PIN_AE15 3.3V LVCMOS 
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ピン配置情報のimportと割当 
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構成情報の生成 

• Processing -> Start Compilationをクリックして，論理合成＆配置配線 
• DE2-115ボードの電源をいれる． 
• Taskウィンドウ内のProgram Device( Open Programmer)をダブルクリック 
• Programmer内にて，Hardware Setupボタンをクリック． 

– No Hardwareとなっている所をUSB-Blaster USBを選択して，closeボタ
ンをクリック 

• Start ボタンを押して，Progress が100%(Successful）になればOK 
• Programmerを閉じる 
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Workspaceの設定 

• ハードウェアのプロジェクトディレクトリの下にsoftwareというディレクトリを作る
．（例：ContestSys05/software） 

• QuartusのメニューTools->Nios II Software Build Tools for Eclipseを選
択する 

• EclipseのメニューFile -> Switch Workspace -> Otherを選択し，上記で作成
したContestSys05/softwareを選択する．（初めてEclipseを立ち上げた場合
は，いきなりWorkspaceの選択から入るかもしれない） 
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新規プロジェクトの作成 

• File -> New -> Nios II 
Application and BSP from 
Templateを選択 

• Target hardware informationの
SOPC Information File nameに
は，Quartusのプロジェクトディレク
トリにあるnios2_sys.sopcinfoを選
択する 

• Project nameを「400oflow」とす
る 

• Project templateにはBlank 
Projectを選ぶ 

• 以上で，Finishボタンを押す 
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BSPの設定 

• 400oflow_bspを選択した状態で，右クリックし現れるメニューで， 
Nios II -> BSP Editorを選択 

• 現れるWindowの中のLinker Scriptを選択し，”.bss”, “. heap”, などを全て
onchip_memoryに置くように設定する 

• Nios II BSP EditorのFile メニューの中からSaveを選択する 
• Generateボタンを押し，Exitボタンを押す 
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BSPを保存するときの 
Fileメニュー 
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BSPのBuild 

• 400oflow_bspを選択した状態で，右クリックし現れるメニューで， 
Build Projectをクリック 

• Consoleにて，”[BSP build complete]”が出力されている事を確認 
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400oflowのBuild 

• ファイルの準備 
– コンテストのサイトから配布されている400oflow_v10.tgzを展開し，

400_oflowディレクトリに移動し，そこでmake exportをする． 
– 上記により，export/altera/src/の下にnios用のソースファイルが生成さ

れる 
– software/400oflowディレクトリに移動し，export/altera/srcディレクト

リにあるファイルを全てコピーする． 
• Eclipse上で，400oflowプロジエクトを選択した状態で，右クリックし現れるメニ

ューで， 
– Refreshをクリックする 
– Build projectをクリックする  
– Run As -> Nios II Hardwareをクリックする 

• 後はホストPCから画像の転送プログラムなどを動かせばOK 
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Alteraのリファレンスデザインの変更について 

• PLLにより生成されるクロックを修正した時は，define.vにあるSYS_CLOCKの
値も変更してください． 
– 例：50MHzを100MHzにしたら，SYS_CLOCKも100にする 
– 理由：この値をベースに，contest_uart内のuartの受信モジュールが1つ

のシリアルデータの長さを決めています．そのため，この値が実際のクロッ
ク周波数と異なっていると，UARTの受信データが期待したものになりませ
ん． 

• Nios II/fを使用し，データキャッシュを有効にした場合は，communication.c
でのUARTへのアクセスの記述を変更する必要があります．変更内容は次ペ
ージに示します． 
– 理由：volatile宣言された変数であってもコンパイラはキャッシュをバイパス

するldio/stio命令を使用しません．そのため，キャッシュをバイパスさせた
い時にはHALにより提供されるIORD, IOWRなどのマクロを使います．（
io.hのincludeが必要） 
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データキャッシュを使用する場合の 
communication.cの変更点 

変更前 
 
 

• 40行目： 
while((*status & 0x01) != 0x01 ) { 
 

• 51行目： 
data[i]=*val; 
 

• 69行目： 
while( (*status & 0x4) != 0x04 ) { 
 

• 72行目： 
*tx = c; 

変更後 
• 追加： 

#include<io.h> 
• 40行目： 

while((IORD(CONTEST_UART_STA
TUS,0) & 0x01) != 0x01 ) { 

• 51行目： 
data[i] = 
IORD(CONTEST_UART_RX,0); 

• 69行目： 
while( ( 
IORD(CONTEST_UART_STATUS,0
) & 0x4) != 0x04 ) { 

• 72行目： 
IOWR(CONTEST_UART_TX, 0, c); 
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プロセッサ設計部門 
予選のための設計データの提出方法 

• 予選データの提出期限は，日本標準時 ２０１４年８月４日（金） 午後１時です． 
– 参加チームは，上記期限までに参加登録をおこなってください． 

• 提出方法： contest_support@virgo.is.utsunomiya-u.ac.jp までメール 
– メールには、登録チーム名・使用したFPGAボード名を記入してください。 

• 提出するファイルは次の6種類のデータを1つのZIPファイルにまとめたものとします． 
1. FPGAの回路情報のファイル名はXilinxの場合は System.bit，Alteraの場合はSystem.sof 

としてください． 
2. アプリケーション 310_sort のためのユーザファイル． 

ファイルサイズ 256KB，ファイル名 310sort.bin としてください． 
3. アプリケーション 320_mm のためのユーザファイル． 

ファイルサイズ 256KB，ファイル名 320mm.bin としてください． 
4. アプリケーション 330_stencil のためのユーザファイル． 

ファイルサイズ 256KB，ファイル名 330stencil.bin としてください． 
5. アプリケーション 340_spath のためのユーザファイル． 

ファイルサイズ 256KB，ファイル名 340spath.bin としてください． 
6. 審査の参考資料として，1～4ページの原稿（情報処理学会研究報告のフォーマット）を提出して

ください．PDF形式，ファイル名は document.pdf としてください． 
https://www.ipsj.or.jp/kenkyukai/genko.html 

• 受け取った予選データを用いて，直ちに，動作検証をおこないます．正しく動作しない場合には，その
旨を通知し，データの再提出を求めることがあります．データ提出後，しばらくは電子メールに直ちに
返信できるようにしてください． 
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コンピュータシステム設計部門 
予選のための設計データの提出方法 

• 予選データの提出期限は，日本標準時 ２０１４年８月４日（金） 午後１時です． 
– 参加チームは，上記期限までに参加登録をおこなってください． 

• 提出方法： contest_support@virgo.is.utsunomiya-u.ac.jp までメール 
– メールには、登録チーム名・使用したFPGAボード名を記入してください。 

• 提出するファイルは次の3種類のデータを1つのZIPファイルにまとめたものとします． 
1. FPGAの回路情報のファイル名は Xilinxの場合は System.bit，Alteraの場合はSystem.sof 

としてください． 
2. アプリケーション 400_oflow の動作のために必要な設計データ一式と，動作手順書． 

予選では実行委員の手によって提出デザインを実際に動作させるので，そのために必要なデータ一式です． 
ソースコード等の提出は必要ありません． 

3. 審査の参考資料として，1～4ページの原稿（情報処理学会研究報告のフォーマット）を提出して
ください．PDF形式，ファイル名は document.pdf としてください． 
https://www.ipsj.or.jp/kenkyukai/genko.html 

• 受け取った予選データを用いて，直ちに，動作検証をおこないます．正しく動作しない場合には，その
旨を通知し，データの再提出を求めることがあります．データ提出後，しばらくは電子メールに直ちに
返信できるようにしてください． 
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両部門 
FIT2014デザインコンテスト予稿集原稿 

• 決勝に進出したチームには，原稿（1～4ページ） を執筆していただきます． 
– 提出日： 日本標準時 ２０１４年８月２２日（金） 午後１時 
– 提出方法： contest_support@virgo.is.utsunomiya-u.ac.jp までメール 

 
• この予稿集は、FIT2014本体の予稿集とは別に、コンテスト独自に作成するものです。 

 
• 原稿は予選時に提出したものと同様に、情報処理学会研究報告のフォーマットで作成してください． 
• PDF形式，ファイル名は （予選通過時のチーム番号）.pdf としてください 例）P1.pdf 

– https://www.ipsj.or.jp/kenkyukai/genko.html 
 

– 以下の事項に同意いただいた上で、提出をお願いいたします。 
• 著作権は著者に帰属するものとします。 
• 作成した予稿集は、電子データで、コンテストの参加者に配布します。 
• 提出されたPDFの、情報処理学会研究報告のテンプレートに含まれる著作権表示・ページ数等の表記を、実行

委員にて編集させて頂くことがあります。 
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両部門 
決勝での競技方法 

• 決勝では各自FPGAボードを持ち寄り，コンテスト実行委員が用意するexStick,およびホストPCと接続
してその場で処理時間を計測する競技を行います． 

– 設計データの提出は必要ありません． 
– 処理時間の計測が可能なように，各参加者が準備を行ってください． 

 
• 決勝当日の本番前に接続テストを行いますので，決勝に進出した方は参加してください． 

– 詳細は後ほど連絡します 
 

• 2014年9月5日午後 開催の決勝戦イベントセッション＠筑波大にてポスター発表していただきます．  
 
 

• 以上の条件を満たせないチームは失格となりますので，注意してください．  
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改訂履歴 

• Ver.2014-08-17 
– プロセッサ設計部門のルールDocument P37を修正 

• 320_mmの出力値をチェックサム→CRC32に変更しました 
• 各アプリケーションのデータサイズ上限値を明記（第1回コンテストと同様） 

– Document P70にFIT2014デザインコンテスト予稿集原稿の提出方法を追加 
• Ver.2014-07-28 

– 予選のための設計データ提出方法に関する記述(P.70)を追加 
• Ver.2014-07-03 

– 参加可能ボードに関する情報を追記 
– コンテストルール９、ホストとの通信方法を追記 
– コンピュータシステム設計部門リファレンスデザインに関するドキュメントP51, P61, 

P62をマージ 
– その他微修正 

• Ver.2014-06-08 
– DE2ボード版リファレンスデザインの説明追加 
– 各種配布物のバージョン情報の更新・その他微修正 

• Ver.2014-06-06 
– 初版 （第1回コンテストの内容に追加変更をした） 
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